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Introduction

About this Manual i

Part 1: Introduction

About this Manual

Intended Use of this Manual

e This manual describes the common use procedures of the PlateWriter 2000 System.
It is intended for the daily user and should be kept with the equipment for reference

at all times.

Printer-specific information relating to operation, maintenance and service can
be found in the manuals supplied on the CD with your printer.

Reservations

e This manual was written and illustrated using the best possible information avail-

able at the time of publication.

» Any differences between this manual and the equipment reflect improvements intro-
duced after the publication of the manual.

» Changes, technical inaccuracies and typographical errors will be corrected in subse-

quent editions.

» As a part of our policy of continuous improvement, we reserve the right to alter de-
sign and specifications without further notice.

Notes, Cautions, and Warnings

Throughout the manual notes, cautions, and warnings are written in bold like the

example below:

Always replace a fuse with one of the same size and rating as the old one.

Symbol

Meaning

Explanation

Note

The operator should observe and/or act according to the
information in order to obtain the best possible function of
the equipment.

Caution

The operator must observe and/or act according to the
information in order to avoid any mechanical or electrical
damage to the equipment.

A

Warning

The operator must observe and/or act according to the
information in order to avoid any personal injury.

Operating Manual - PlateWriter" 2000
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Introduction

iz Important

Important

Safety and Use

 Before using the equipment it is assumed that it has been properly installed and con-
figured as described in the installation manuals delivered with the system.

e The manufacturer cannot be held responsible for any damage caused by incorrect
use of this equipment.
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The PlateWriter 2000 Systern ialid

The PlateWriter 2000 System

The PlateWriter 2000 System is an innovative and patented inkjet Computer-to-Plate
(iCtP) device.

The PlateWriter System consists of:

o PlateWriter Engine (1)
A specially modified Epson Stylus Pro 4880 inkjet printer that uses Glunz & Jensen's
Liquid Dot fluid to image the iPlates printing plates.

¢ Plate Input Table (2)
A table for aligning plates prior to entering into the PlateWriter 2000 Engine.

¢ Proofer
An unmodified Epson Stylus Color 4800, 4880 or 7800, 7880 printer used for proof-
ing. Plug-ins to drive these printers are supplied with the Harlequin RIP

e Harlequin RIP Platform
A customized workstation accessible by both Mac and PC computers, loaded with
the latest version of the Global Graphics Harlequin RIP.
The Harlequin RIP provided is customized by Xitron and it accepts PostScript, PDF,
EPS, TIF & JPEG files produced by standard pre-press applications.
It RIPs the data and sends output to the PlateWriter Engine or to the Proofer

o PlateWriter Finishing Unit (3)
An integrated plate finisher that executes all of the steps necessary to produce
press-ready plates, i.e: curing, gumming and drying of the plates after they are im-
aged in the PlateWriter Engine.
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1-4 Introduction
PlateWriter Overview

PlateWriter Overview

1 Front Plate Table: place plates here before printing.

2 Control Panel: from here you control the Imaging Unit (see details on page 1-6).

3 Input table: Ensures that plates are aligned correctly prior to entering the Imaging Unit.

4 Ink Dryer: improves the drying of the Liquid Dot ink on the plate.

5 Rear Plate Table: when a plate has been loaded it will be transported to here before
printing starts.

6 Curing Conveyor: leads the printed plate through the curing sections.

7 Curing Oven: dries the ink on the plate and cross-links it to the aluminum base.

8 Gum/Finishing Bottle: contains the finishing solution applied to the plate in the finishing
section. Solution not accepted by the plate returns into the bottle.

9 Finishing Section: cools the plate and applies a combined gum- and plate enhancer to the
plate to protect it from oxidation and to improve its press characteristics and hydrophilic
properties when on press.

10 Gum Dryer: dries the plate to provide a finished, dry plate.

11 Plate Exit Tray: holds the finished plates.

12 Ink Cartridges: There are two compartments on each side of the printer. Each compartment
can contain up to 4 ink cartridges.
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Introduction 1-5
PlateWriter Overview

21

13 Status Indicator LED: indicates the current status of the Finishing Unit.
14 Program Selector: for selection of the Curing Oven program.

15 USB-cable: connects the Imaging Unit with the RIP Workstation.

16 Power Cable: supply voltage for the Imaging Unit.

17 Power Switch: press here to switch the Imaging Unit On/Off.

18 Power Switch: press here to switch the Finishing Unit On/Off.

19 Power Cable: supply voltage for the Finishing Unit.

20 Control Cable: connects the Ink Dryer with the Finishing Unit.

21 Power Cable: supply voltage from Finishing Unit to the Ink Dryer.
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Part 2: Daily Use

Overview

The daily use procedures described in this chapter cover the following issues:
e Daily Start-Up procedure

» Loading of plates into the PlateWriter for printing

¢ Printing of plates

¢ Finishing

¢ Daily Shut-Down procedure

Daily Start-Up

o Start the RIP Workstation (1).
e Launch the RIP Application (2).

» Replace the finisher solution in the fin-
ishing bottle (3) with fresh finisher so-
lution.

ﬂ Half a bottle is sufficient.

%
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2.2 Daily Use

Daily Start-Up

o If you see the message MNT TNK

FULL on the LCD display, you need
to replace the maintenance tank.
Place the used tank in the plastic
tank supplied with the new tank. In-
sert the new tank.

Switch on the Finishing Unit on the
main switch (5) underneath and
make sure that the indicator (6) lights
steady green.

The unit will run gum fluid through
the system for approximately three
minutes to ensure an even gumming
of the plates.

This will also switch on the Ink
Dryer.

e Switch on the PlateWriter by press-

ing the [POWER] button.

e The PlateWriter initializes and when

finished, the display (8) shows
"READY”.

0748
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Daily Use

Making a Proof

Creating Files for Proofs

Use your DTP application to prepare a composite output file - please refer to your
application manual for help.

Select an output page size sufficiently large to accommodate your content and any
registration marks or colour bars.

Save the file to a folder, either on the computer running Navigator RIP or on a
server.

Printing a Proof

In the Navigator RIP open the Output Controller / Monitor window by either
pressing Ctrl+O or choosing Output -> Output Controller from the RIP menu.

Be sure that Disable Output is checked.

Select File -> Print file from the RIP menu.

Choose an appropriate Proofing Page Setup and a file type (.ps, .pdf, .eps, .jpg or .tif)
from the dialogue.

Navigate to the folder containing your composite files, choose one file, and click on
Print.

The file will be ripped and will appear in the Active Queue of the Output Moni-
tor/Controller window.

Uncheck Disable Output in the Output Controller/Monitor window. The proof will
be printed.
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Daily Use

Making Plates

Making Plates

Creating Files for Plates

e Use your DTP application to prepare separation output files - please refer to your
application manual for help.

* Select an output page size sufficiently large to accommodate your content and any
registration marks or colour bars - it should not be the same size as your plate. The
RIP will position a smaller page correctly on your plate for you.

 Save the file to a folder, either on the computer running Navigator RIP or on a
server.

Loading Plates on the PlateWriter

The input table ensures that plates are fed into the printer correctly. The side register
rollers (see below) enable correct and easy alignment prior to entering the printer.

¢ Place the plate on the input table against the register wheels on the left side and slide
the plate into the printer.

o If the plate is fed incorrectly into the printer, the LCD display will show the message
“NOT STRAIGHT - RELOAD”.
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Daily Use

Imaging the Plate

Imaging the Plate

In the Navigator RIP open the Output Controller / Monitor window by either
pressing Ctrl+O or choosing Output -> Output Controller from the RIP menu.

Be sure that Disable Output is checked.

Select File -> Print file from the RIP menu.

Choose an appropriate PlateWriter 2000 Page Setup that matches your print job and
the orientation of the loaded plate, then choose a file type (.ps, .pdf, .eps, .jpg or .tif).
Navigate to the folder containing your separation files, choose the files, and click on
Print.

The files will be ripped and will appear in the Active Queue of the Output Moni-
tor/Controller window.

The ink (colour) of each separation will be displayed in brackets after the job name,
and if there are multiple pages, then each page will be designated with a numeric

value.
= Raw - 24.0Mb, Compressed - 16.6Mb, Ratio - 1.44:1

paration: 26 seconds x|
tion ""Magenta’ to disk... :
friter Ztone 1003 inking Reading from;  Graph Expo 2 up v 1.ps
2 Baw . 24 Nhdk T Aarsmracca, A 1E Fhdb Pabim o1 A2 -
h e T z read: 39757 0Kb
| Eﬂutput Controller / Monitor 5' — ﬂ
i Fainting to Dizk:
| (s - ent job
i Active Queue e D el Eﬁ?é Held Queus

1. Graph Expo 2 up v 1.ps [C] _ |
i 1. Graph Expo 2 up v 1.pz [M] 4 .

1. Graph Expo 2 up v 1.ps [v] Type LT+ to kill curent job
| 1. Graph Expo 2 up v 1.ps (K]

1. Graph Expo 2 up v 1.ps [PAMTOME Red 032 CVC)
I 1. Graph Expa 2 up v 1.pe [PANTOME Cool Grap 8 CWC)
H 1. Graph Expo 2 up v 1.ps [FPANTOME Fed 032 ] Bieiin
|

¥ Dizable utput
It I Hemaye | Bioam |
Delete: IWhen NECessarn 'I
Items: 7 Uszage: 60.0Mb Dk free: 319.9Mb ltems: O Uszage: OKb

Select your file and click on Info.
The ThroughPut Info window appears.

Througheutio x

Job: 1. Mailinglabel [PANTOME 330 C)

Output device:  |PlateWwiiter 24381 v|  Resolutions  2880.00 Yertical
Corfigure device.. | [dpi »] 2880.00 Horizontal

Fage width: 9.00 Iinches TI Copiez to print: I'I

Fage height:  11.79 Copiez printed: 1

[~ Megative Change roam color... |
k [ Trim page [T Don't delete page
Size ondizk:  4615Kb

Eazzette; I j ¥ Change all pages in job

Erposure: I OF. | Cancel
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Daily Use

Imaging the Plate

* Be sure that Change all pages in job is checked.
 Click on Page layout... to open the Page Layout window.

Page Layout i x|

4 ou M Device Width [DW]: 45398
Device Length [DIL]: 1016.00

tedia Size: IDlher VI
I edia width [k ]: |34D.DD
tedia Length [tL]: |5E|5.EIEI

Top Margin [Th]: IED.DEI

(PRSI YA

v Center page on Media ‘width

Bottom kargin [Bh]: 5.00
[ Center page on Media Length

Left Margin [Lk]: 10.00
Page size: IDther j Right targit [Rr4]: 10.00

Page width:  [320.00 Imillimeter& | Selact units: Imillimeters j'
Page height: [450.00 @ Cancel |

Check that the size of your plate is correctly entered in the Media Width [MW] and
Media Length [ML] boxes. Most plates will be imaged portrait in the PlateWriter
2000. Depending on whether you are loading the plates in portrait or landscape and
whether you have a portrait or landscape press, different selections have to be made.
If you load the plate in portrait and have a landscape press, be sure to select the
Center page on Media Length and set the Left Margin [LM] to accommodate the
normal unprintable area on your press. (also known as the Grip).

If you have a portrait press, and have loaded the plate portrait, then make sure to se-
lect the Center page on Media Width and set the Top Margin [TM] to accommo-
date the normal unprintable area on your press.

Click OK in the Page Layout window and in the ThroughPut Info window.

Drag all but the first separation of your job to the Held Queue.

Uncheck Disable Output in the Output Controller/Monitor window. The first plate
will be printed.

Remove the plate from the PlateWriter and place it on the front of the Plate Writer
finishing unit, see finishing procedure in the following section.

For subsequent plates, make sure that Disable Output is checked, load a plate into
the PlateWriter 2000, drag one separation from the Held Queue to the Active
Queue, and then uncheck Disable Output.
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Daily Use
Imaging the Plate

Finishing
e Use +/- buttons on the Program Se-
lector (1) to select program:

1 =0.15 mm plates
2 = 0.20 mm plates
3 = 0.30 mm plates
4 = Gumming only/Gum Rinse

Program 0 is for technicians
only!

e Make sure that the indicator (2)
lights steady green.

For the various indicator status
and error codes please see chap-
ter 5 “Troubleshooting”.

¢ Place the printed plate (3) on the con-
veyor making sure that the front
edge is placed over the plate sensor
4).

o If the curing oven has already
reached the correct working temper-
ature, the conveyor will take the
plate through the oven, otherwise it
moves the plate slightly forward and
then it stops until the oven is ready.

¢ The indicator (5) will start to flash in-
dicating that the unit is busy. Do not
insert another plate while indicator is
flashing.

* When finished the plate is placed on
the exit tray (6).
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Daily Use

Daily Shut-Down

Daily Shut-Down

* Switch the unit into OFF-mode by pressing and hold-
ing the [POWER] key (1) for 2 secs. All lights turn off
and the display will go blank.

e When in OFF-mode the unit will still “wake up” at
intervals and perform the maintenance cycle and
then automatically return to OFF-mode.

Important notes about switching the Power On and Off

Never switch off the main power while the sub power is switched on. The printing
heads may be left uncapped (the printing carriage may remain over the Plate
Alignment Mat). If the machine is left unused with the printing heads uncapped for a
prolonged period, the printing heads may become irreversibly clogged.

Before switching off the main power, be sure to hold down the [POWER] key for one
second or longer to switch off the sub power.

If the printing carriage stops while over the platen, press the [POWER] key to reset the
power. The printing carriage moves and the printing heads are capped.
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Part 3: Cleaning & Maintenance

Overview

This section describes the various procedures for care and maintenance such as:

Printer

Please refer to the Printer Guide

Finishing Unit

» Replacing the Gum/Finisher Solution (Daily)

e Running the Gum Rinse Program (Weekly)
 Cleaning of the Gum/Finisher Rollers (Monthly)
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Cleaning & Maintenance
Inks and Fluids

3-2

Inks and Fluids

The PlateWriter requires the use of various inks and fluids for processing, cleaning and
maintenance purposes:

Liquid Dot™ (1)

The Liquid Dot™ ink is supplied in special cartridges and used in the imaging channels
to create a hydrophobic image on the printing plate.

Maintenance Fluid (2)

The Maintenance Fluid is a general purpose fluid supplied in special cartridges, and is
used to keep the unused print heads available for use as backups. It can also be used as

a light cleaning fluid.
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Cleaning & Maintenance

Replacing the Ink Cartridges

Replacing the Ink Cartridges

If ink runs out, replace the cartridges as described in the following.

Never use any ink other than genuine Liquid Dot ink from Glunz & Jensen.
Doing so may result in malfunction or faulty operation.

Care and Handling of Ink Cartridges

Give attention to the following points when handling ink cartridges.

Never attempt to install any ink other than a Liquid Dot cartridge.

Never attempt to disassemble.

Never drop or allow to fall. The impact from a fall may cause damage, making the
cartridge unusable.

Store unopened in a well-ventilated location where the temperature is from -20°C
(-40°F) to 40°C (104°F).

Once an ink cartridge has been installed, never remove it until the ink has been used
up, except when moving the machine.

Frequent insertion and removal may cause air to enter the ink tube, resulting in dot
drop-out or other problems in printing quality.

Always be sure to gently shake the ink cartridge before you install it.

Removing or inserting an ink cartridge while operation is in progress may cause air
to get inside the cartridge, resulting in poor image quality.

After removing an ink cartridge, never allow the machine to stand with the ink-car-
tridge port remaining empty — install a new ink cartridge immediately. Failure to
do so may result in clogging of the heads.
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Cleaning & Maintenance

Other Printer Cleaning Tasks

Other Printer Cleaning Tasks

General

Exposed areas of the machine may become soiled with ink during printing.
The cleaning methods described below let you continue printing without affecting the
printed media or the machine.

When carrying out any cleaning other than cleaning using cleaning sticks,
switch off the main power (before turning off the main power, press the
[POWER] key to switch off the sub power.)

Never lubricate the mechanisms.

Never clean with solvents (such as benzine or thinners).

Never touch the printing heads or allow the printing heads to come in contact
with anything except ink.

Cleaning the Printer Body

Use a cloth moistened with water then wrung well, and wipe gently to clean all
surfaces.
Wipe the operation panel and LCD display gently with a clean, soft cloth.

Do NOT put wet plates back in the printer. This will cause the image to
transfer to the rollers and on every subsequent plate!
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Cleaning & Maintenance
Finishing Unit

Finishing Unit
Running the Gum Rinse Program

It is recommended to run the Gum Rinse Program at the end of each working
period (preferably once a week).

» Replace the solution in the Gum/Finisher bottle with warm water.

¢ Select Program 4 on the Program Selector to start the Gum Rinse Program.

* The unit will run for approximately 10 minutes recirculating the water through the
gumming system and then it switches to stand-by mode.

* Leave the unit with water until the start of the next working period, then replace the
water with fresh Gum /Finisher Solution.

Danger of crushed fingers when working inside the Finisher section, proceed
with caution. Always replace the side plate after completing cleaning and
maintenance tasks in the Finisher section.

“ Always replace the side plate after cleaning and maintenance of the Finisher
section. Failure to do this will result in inferior processing quality.

Procedure for accessing the Gum/Finisher section
See figure opposite

o Turn off the power supply to the machine.

e Remove the plug from the socket.

o Lift the side plate by its knob and push it into the recess where it can be stored while
working in the section.

You can also remove the covers of the curing oven and gum dryer for easier access.
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Cleaning & Maintenance
Finishing Unit

Cleaning of Gum/Finisher Rollers
ﬂ It is recommended to perform this cleaning procedure once a month.

(See illustration opposite)

o Switch off and unplug the Finishing Unit.
* Remove the Gum Dryer (1).

e Remove the Gum Section Cover (2).

» Take out the roller (3).

* Release the roller bearings (4) and take out the rollers (5) and (6).
To release the roller bearings, press the locking arm as illustrated, and then pull up-
wards.

¢ Clean the rollers and bearings in hot water using a soft brush.

 Reinstall all parts in reverse order, making sure that the bearings (4) click properly
into place.

Cleaning the Finishing Unit Body

Use a cloth moistened with water then wrung well, and wipe gently to clean all
surfaces and conveyor belts.
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3-8 Cleaning & Maintenance
Finishing Unit

Gum/water Replenishing System

Use

» Depending on the size of the plate, the finishing unit sets aside a little water pump
run time (approximately 1 s for every 60 seconds that the finishing unit is running).
Once the plate has passed through the machine, the water pump replenishes the re-
served amount of water and distributes it to clean the rollers.

« If plates are continuously running through the finishing unit, it will continue reserv-
ing water replenish until it has accumulated 30 seconds. The finishing unit lights
green (ready) as soon as water replenish is added.

Do not turn off the finishing unit before it is ready (green). This ensures that
water replenish is added and will stop the rollers from sticking together the
next day.

o If the finishing unit is turned off before re-
plenish has been added, any saved replen-
ish will be deleted.

o The water tank (1) must be placed below
the gum bottle with the cap in the tray dis-
mounted. The water tank functions as a
drip tray for the gum bottle.

Cleaning

» The water tank must be emptied and
cleaned once a week, for instance when
changing gum.

* Refill with demineralised water only to
avoid contamination of gum/plates.

» With the gum/water replenish system installed, gum should only be changed /re-
filled and cleaned once a week.

Gum consumption will be approximately 20 g/m?.
Water consumption will be approximately 40 g/m?2.

Depending on the throughput in the finishing unit, you should calculate how
much gum and water to put in the gum bottle and water tank to make the gum
last one week. If there is less than 25% gum remaining in the bottle when
commencing work with the printer in the morning, it is a good idea to top up.
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Using the RIP

Overview of the Navigator RIP o

Part 4: Using the RIP

Overview of the Navigator RIP

The Navigator RIP is an application that takes a document or job describing images or
pages and produces output from that job on an output device - which in this case is
either the PlateWriter 2000 or a proofing device.

In general, a software application or hardware device that performs this task is known as
a Raster Image Processor (RIP) or, where the PostScript” language is involved, a
PostScript-language compatible interpreter.

The iCtP RIP workstation is not just a Navigator RIP, it is a RIP management system.
It contains both a RIP and a collection of supporting functions that help the RIP
perform its task efficiently.

For example, the iCtP Workstation accepts jobs from various platforms such as Mac or
PC, different sources (from disks, CD’s, shared folders on Networks or virtual printers
visible to other users), the iCtP RIP Workstation also handles previewing and output of
processed pages, and performs the associated file handling.

Input formats

The Navigator RIP accepts jobs from most major graphics applications and supports
the following formats, with the exact options depending on your configuration of the
RIP.

The input formats includes:
 PostScript-language (PS) files

e Encapsulated PostScript (EPS) files
Portable Document Format (PDF) files
TIFF/IT-P 1 files

(16-bit) TIFF 6.0 baseline files

JPEG and JFIF files

The Navigator RIP supports modern versions of these files including PostScript
Language Level 3, PDF version 1.5, and derived standards such as PDF/X.

The RIP also has controls for special handling of older versions of these files if
necessary.

The Navigator RIP can produce output in a variety of formats to suit various physical
output devices and file formats.

Similarly, there are options for output to many proofing printers and final output
devices. Each device, may have certain size limitations, as well as the ability to handle
colour (for proofing) or separations (for plate-making). In turn each of these devices
will have its own gain characteristic and require calibration.
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Concepts and Definitions

Once the RIP is installed, a one-of set up is required to create a “base” from which the
RIP will operate, and from time to time you may find it necessary to update or modify
the settings to suit your ever-changing requirements.

As there is a great deal to set up, Glunz & Jensen has created the config.ps file (found
in the C:\Program Files\ Xitron Navigator7.1r0\Factory Defaults folder).

The file contains a “Basic Set-up” covering all the settings and calibrations required for
several plate sizes and can be loaded into the RIP upon start-up.

Printing the config.ps file installs all the items required for an initial set up of the RIP
including setting memory allocation, the RIP mode, buffers as well as some default
calibrations, tone curves, and page setups for plate-making.

Once these have been loaded and the RIP restarted, (and your unlock codes entered as
described in the previous section) you can use the following procedures outlined in
this section to assist you in editing the existing setups, duplicating them for the basis of
new setups or creating new page setups and calibrations customized for your press.

Basic Concepts and Definitions

This section is intended as a guide to cover the basics required for operating the
Navigator RIP and to get you started.

For a much more detailed explanation of the RIP or each of these definitions please
consult the separate RIP User Manual located in your Manuals folder in the main RIP
folder.

Many of the main functions and items referred to in this chapter are briefly described
below:

* Devices: are essentially combinations of a physical printer, a software screen
method, and printer-to-computer connection (i.e. USB).

 Separation Styles: have to do with how separations and composite files are handled
by the Navigator RIP. You can use a “Composite” style to print composite or
pre-separated files, a “Separations” style to separate composite files in the RIP (in-
cluding limited trapping), and a “Progressive” style to produce progressive proofs
from composite files.

o Page Setups: are sets of information required for printing a plate, such as device,
resolution, media size, calibration and tone curves, margins on the media, rotation,
etc.

* Media Size: when making a Page Setup this will be the size of your printing plate
OR the size of the paper used for making proofs.

o Page Size: is the size of the PostScript or .pdf file that is sent from your pre-press ap-
plication. When you create or edit a Page Setup, the default Page Size is arbitrary.
The RIP will override that setting with the size of the file you send to the Navigator
RIP.

 Calibration Curves: are used to linearize the output of your Plate or proofer and to
add tone curves to your output.

Printing config.ps installs: PW2000_371/219 which is a Calibration Curve for Plate
Writer-2000 using Glunz & Jensen i-plates.

For proofing we have enabled the RIP to support Epson 4800 and Epson 7800 print-
ers, within the Config dialogue box for each proofing device are several built-in cali-
bration curves (shown with Green ticks) for various Epson papers and inks.
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e Actual Press Curves: are used to linearize dot gain from the printing press, or to em-
ulate the characteristics of another press.

 Printing config.ps installs general press curves which are press calibration curves for
linearising Glunz & Jensen i-plates on most commercial printing presses.

 Please note that these are default curves. To achieve a more accurate calibration, you
may wish to create your own curves.

* Intended Press Curves: are used to rebuild the desired dot gain from the printing
press, or to emulate the characteristics of another press.

 Printing config.ps installs Industry standard: Commercial A, SWOP and Fogra
curves, 15%, 20% & 22% gain curves (plus others) which are calibration curves used
to take the linearised Glunz & Jensen -plates where 10% will print as 10%, 30% as 30%
and 50% as 50% etc., which to many users (particularly with four colour work) will
create flat-looking images.

e The intended press curves, ADD back the gain achieved with conventional halftones
(such as produced by plates made by film) on most commercial printing presses.
Please note that these are default curves. To achieve a more accurate calibration, you
may wish to create your own curves.

» Tone Curves: are used to adjust dot gain further (they can be used to create a cooler
looking image, or to create more saturated images).

* No curves are installed with the config.ps, these can be generated by the user.
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Setting Up Devices

* Make sure that the PlateWriter 2000 is on and connected to your computer.

o Start the Navigator RIP and select NavigatorRIP -> Device Manager from the appli-
cation menu.

Flugir: IPIateWriter2DDD.i32 'l
M ame: | Type | Addresz

Flatetwfiter 2488 Dot Double  Platetwfiter 2488 Dot Double

Platetwfriter 2488 1 bit Double  Platetw/riter 2488 1 bit Double

Flateiwriter 2445 wDiot Plateiw/riter 2445 vDot

Platetwriter 24451 bit Platetw/riter 24451 bit

Flatetariter 2488 wDiot Flatehw/riter 2488 vDot

Platetwfriter 2438 1 bit Platetw/riter 2438 1 bit

4800 Platetwriter 2480 1 bit

L« | i
Edit... | Mew... | Copy... | Delete |

Select | ok I Cancel |

e Ensure the PlateWriter2000 appears in the Window. If it does not, then check that
you have entered the password for the PlateWriter2000 correctly (in the Navigator->
ConfigureRIP -> Extras dialogue box - when revisiting the ConfigureRIP -> Extras
Window, the device Platewriter2000 should have the word YES next to it if the pass-
word entered was correct).

e The Device Manager window lists the device types that are available for the
PlateWriter Plugin, PlateWriter2000.i32. The iCTP PlateWriter 2000 is the default
name for the PlateWriter Output device and more options are available here. Select
2488 1 bit Double (for PW based on Epson 4880). This window gives you the ability
to duplicate or rename the device or add other devices supported by the plugin.

* Based on experience with the PlateWriter 2000 and the Navigator RIP, we strongly
recommend to leave this unchanged (whilst not needing to change this device, you
may need to use this window to add proofing items under the iCTP plug-in).

Creating Separation and Progressive Styles

Separation Styles

A Separations Style is a definition used by the RIP to characterize how a file arriving
will be handled, how the colours will be separated out and what screening will be
used. There are many types of work flows used in the print environment to send files
to bureaus and to CTP equipment. One of the most popular is a pre-separated
workflow where users output their jobs in separations directly from the application.
There are others where users prefer to send composite jobs and allow the RIP to handle
the separations. There can be circumstances where files arrive in a format where
incorrect colours have been used and you want the RIP to override the separations.

A more extensive explanation is found in Chapter 14 of the Xitron RIP Manual located
in your manuals folder in the RIP installation folder.
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Predefined Separations Styles

To make things easier, if you printed the config.ps file as described earlier, then it will

have already installed some separations styles for you.

* Select Color -> Separations Manager from the NavigatorRIP menu.

BNavigator 5 i =] |
Mavigator Edit  Preview | Color OQukput  Fonts
o B 5 S = .
po ke Simpaks
Color Rendering Inkent Manager. .,
DolFerfect DEEDS Ztone (1. _0lcY Setup Manager.., 0a =]
DotPerfect DEEDS 2tone [1-  Install ICC Profile... 00a
DiotPerfect DEEDS 3-tone 2 Uninstall ICC Profiles.. .
DotPerfect DEEDS 3tane [2 -
DotPerfect DEEDS 4-tone [2-bit] smooth screening plugin: 5.00a
DotPerfect DEEDS 4-tone [2 bit] zcreening plugin for Platetfiter 6.00a
Harlequin Errar Diffuzion Screening 1-bit Plugin Yersion 2,111 - Copyright (2] 1938-2003 Global Graphics Software Limited. All Rights Reserved.
Harlequin Error Diffusion Screening 2-bit Flugin Yersion 2.111 - Copyight (] 1938-2003 Global Graphics Software Limited. &1l Rights Reserved.
CRD Generator Plugin: Yersion 7,110 - Copyright [] 1995-2005 Global Graphics Software Lid. All Rights Reserved.
Initial memory: 26320 kB used, 899840 kB reserved
Loading Harlequin RIF JOF connection +1.4.1.113.1.1 - Coperight [c] 2004 Global Graphics Software Ltd. All Rights Reserved.
Loading PostScript language control AP v1.7.1.18.1.1 - Copyright [c] 2004-2005 Global Graphics Saftware Ltd. All Rights Reserved.
Loading in-RIP imposzition suppaort +1.20.1.50.1.2 - Copyright [c] 2000-2004 Global Graphics Software Ltd. Al Rights Feserved.
Loading color bar support +1.1.2 - Copyright (o] 2002-2004 Global Graphics Software Ltd. All Rights Reserved.
Loading simple in-RIP imposition +1.1.1.81.1.2 - Copyright [c] 2004-2005 Global Graphics Software Ltd. &l Rights Reserved.
RIP Yersion Genesis Releaze [7.100] [JDF-ready)
Sernial number: 25177-52
Eil A
¢ This opens the Separations Manager window. Select iCTP PlateWriter2000 as the
device.
N
Device: IPIateWriter 24881 bit D 'l
Style Mame I Color S pace I Output Format I
Separations [CHYE] ChYE Separations
Separations [CHYK + zpot] ChivE Separations
Monochiome or force monochro...  Monochrome Monochrome
Edit... | Mew. .. | LCopy.. | [elete | Select | 0k I Cancel |

The predefined separation styles appear in the list. They should cover all the separa-
tion styles you need, so to create or edit a Page Setup, turn to the section titled Cre-

ating Page Setups for Plate Making later in this section.

However, if you did not print the config.ps file, follow the procedure as described

below to create your own Separation Styles.

Creating Separation Styles

e When opening the Separations Manager window there will be a CMYK separations

style and a monochrome style already entered.

Device: IF‘IateW'riter 24881 bit D 'l

X

Style Mame | Color Space | Olutput Farmat |
ChMYK. Separations ChE Separations
Monochrome Monochrome Monochrome

Edit... Mew... Capy.. | [elete I Select 0k Cancel

Click on New.
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e The New Style... window opens.

New Style for device "PlateWriter 2480 1 bit Doublé x|
[

To create a new Colors, Screening and Separations style
select the Color Space & Output Format and give it a name.
The style needs to be created before you can set the
zeparations and/or screening parameters.

Style name: ISeperations [CHYE + spof)
Color space: I ChYE j
Output format: I Separations j

Create I Cancel |

Give the new style a name that will be easy to remember and reflects what your sep-

L]
aration style will achieve (e.g. Separations (CMYK+Spot) to DEEDs2).

» Set Color space to CMYK.

e Set Output format to Separations.

 Click Create to open the Edit Style dialogue.

Edit Style for "Seperations {CMYK + spot)’ - CMYK - Separations - = Monochrome _ ll
o, | [z Tiede | & ot s it

kagenta Ve
ellow ez W Use Level 1 spat colors

Ta change order select | Black “res
and_ _drag b new [Other job] Mat Blank
position

= Owerride anales it jot

Selninbl e [~ Reject preseparated jobz
automatically print
‘other calars in job'.

Edit selected raw: [Other calars in jab) Mot Blank }l Mew | Delete | ‘

[~ Recombing prezeparated jobs

Mo
N
Dot shape: IDEEDS2P’W’ w 'l ¥ | Gveride dot shape in job
Fiesolution|s | Frequency |

Select row to edit
frequency for ¥ Oweride frequency i job

device resolution.

Edit selected raw: I d I I j

[V Generate extra gray levels Lirnit nurnber of distinct aray levels to: 512 x

I™ Use Harequin Precision Seresting HES Options... |
¥ | Botate screens according o page ratation 0k, I Cancel |

» Choose which process colours you want to print using the pop-up list.
We recommend using Not Blank rather than Yes or No. Not Blank means that the
separation will be produced only if it is found in the composite .ps or .pdf file.
If you select Yes, all separations will be produced, even if they are blank. If you want
SPOT colours to be printed, then set Other colours in job to Yes or Not Blank as

well.
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¢ If you received jobs such as PDF’s from customers that contain multiple Spot and
CMYK colours, and you want to force the separation to CMYK, then create an addi-
tional separation style, set C, M, Y & K to Yes, then Other Colors in job to No.

 Select whether to reject or recombine pre-separated jobs. Pre-separated jobs may
only be recombined if the separations come to the Navigator RIP in a single file.

* Now set the screen to be applied to the image. Set the Dot shape to DEEDS2PW,
this is the Dynamically Even — Extended Diffused Screens that have been designed
specifically for the PlateWriter.

e Check the Generate extra gray levels box, and set Limit number of distinct gray
levels to 512.

 Click OK in the Edit Style dialogue.
* Now your style will appear in the list in the Separations Manager dialogue.

Separations Manager Q 5[
Device: IPIateWriter 24881 bitD Vl
Style Mame | Color Space | Olutput Format |
Separations [CHYE] ChYE Separations
Separations [CHYK + zpot] ChivE Separations
Monochrome or force monochro... Monochrome Monochrome

Edit... | Mew... | Copy.. [elete Select | 0k I Cancel

Click OK to save the changes.
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Creating Page Setups for Plate-making

About Page Setups

The Navigator RIP allows multiple page setups, each can be used to describe how to
handle a job that arrives at the RIP.

The page setup identifies which device will be used to output the file, which
separation style will be applied and thus the screening used to create the halftone.

It also describes the orientation and position of the job on the media, and finally the
actual media size itself.

Multiple page setups can be used for varying press sizes or orientations (such as
portrait presses or landscape presses) in a large print shop to allow plates to be made
for each press and position each plate correspondingly, or page setups can be used to
apply a different separation style if you get jobs from different sources, which have
been created differently. Any combination of the above can also be applied or even a
different output device such as a proofer.

Predefined Page Setups
To make things easier, if you printed the config.ps file as described earlier, then it will

have already installed some separations styles for you.

* Select Navigator -> Page Setup Manager from the NavigatorRIP menu.
=10/ ]

Mavigator Edit Prewiew Color  Output  Fonks
1

e Enr= o 3 i s [

: St reening plugin for Platetw/riter B.00a d

Device Manager ... screening plugin for Plateiwriter B.00a

sereening plugin B.00a
Input Contraller. .. Chrl+H g plugin for Platetsfiter 6.00a
Stark Inputs... Chrl+I zereehing plugin: B.00a

g plugin for Plateisriter B.00a
Executive ChHE Flugin Verzion 2,111 - Copyright (c] 1938-2003 Global Graphics Software Limited. A1 Rights Beserved.

lugin Yersion 2,111 - Copyright [c] 1998-2003 Global Graphics Software Limited. A1l Rights Rezerved.
Language... bpyright [c] 1995-2005 Global Graphics Software Ltd. &1l Rights Rezerved.

; B reserved

Al Nenoeo: 1.4.1113.1.1 - Copyright (<) 2004 Glabal Graphics Software Ltd. All Rights Ressrved.
Logo w1.7.1.18.1.1 - Copyright [c] 2004-2005 Global Graphic: Software Ltd. All Rights Rezerved.
Memary Skatistics .50.1.2 - Copyright (] 2000-2004 Global Graphics Software Ltd, All Rights FReserved,

kit [] 2002-2004 Global Graphics S oftware Ltd. Al Rights Bezerved.
it Chrl4+ 1.1.2 - Copyright (] 2004-2005 Global Graphics Software Ltd. All Rights Feserved.

F-ready]

Senal number: 25177-52
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e This opens the Page Setup Manager window.

x
MHame | Device | Fiesalution | Calibration | Separations Style |
Default Page Setup Preview 100,0 [Mone] ChY'K. Composite
GTO52 PreSepera.. Platetfriter 248... 2880,0 F/2000... Pre separated
GTOR2 In-RIF Sep...  Platewfiter 248 2880.0 Fs2000.. Separations [ChYE]
ABDick 3810 Pre-S... Platetwfriter 248 28800 Fw/2000... Pre separated
ABDick 3810 In-Rl... Plate'wiiter 248, 28800 Pw/2000..  Separations [ChvE)
(M4E Pre separated  Platetfriter 248... 2880,0 F/2000... Pre separated
OM4E In-RIP Sepa.. Platefriter 248, 2830.0 Fs2000..  Seperations [CMYE + spat)
Ed.. oy, | Delere [ Units: [opi -]
oK I Cancel I

Here two different press orientations and sizes are used, and in each case, two dif-
ferent ways to handle jobs arriving have been defined.

You can use these page setups as they are or you can simply change them to meet
your requirements (such as larger plate size) or you can create your own.

However, if you did not print the config.ps file to load the page setups as described
earlier, then you will need to create a page setup before you can use the RIP.

Follow the procedure as described below to create your own page setups if required,
otherwise for an easier way to change the existing Page Setups loaded by the
config.ps file, see the section “Duplicating and Editing a PageSetup” on page 4-22.

Creating Page Setups

* Select Navigator -> Page Setup Manager from the NavigatorRIP menu.

Mavigator Edit  Prewiew  Color  Output  Fonks
1

=10l ]

Prewview

reening plugin for Platehwfiter B.00a ;I
screening plugin for Platetwriter B.00a

zoreening plugin 6.00a
g plugin for Platetster 500z
screening plugin: £.00a

g plugin far Platetariter 5.00a
Flugin Version 2111 - Copyright (] 1958-2003 Global Graphics Software Limited. &1l Rights Reserved.

Conflayre RIP Chrl+R
Device Manaager, .,

Input Contraller... CErl+M
Stark Inputs. .. Chrl+D
Executive Chrl+E
Language...

About Mavigakor

Logo

Mermaoty Skatiskics

lugin Yfergion 2111 - Copyright [c] 1998-2003 Global Graphics Software Limited. Al Rights Rezerved.
bpyright [c] 1995-2005 Global Graphics Software Ltd. All Rights Reszerved.

E reserved

1.41.113.1.1 - Copyright [c] 2004 Global Graphics Software Ltd. All Rights Reserved.

+1.7.1.18.1.1 - Copyright [c] 2004-2005 Global Graphics Software Ltd. &1l Rights Reserved.

50.1.2 - Copyright [c] 2000-2004 Global Graphics Software Ltd. All Rights Reserved.

Quit Chrg

Serial number; 2517752

ht [] 2002-2004 Global Graphics S oftware Lid. &l Rights Beserved.
1.1.2 - Copyright (o] 2004-2005 Global Graphice Software Ltd. All Rights Reserved.

F-ready]
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e The Page Setup Manager dialogue appears.

Page Setup Manager H il
Mame | Device | Fezolution | Calibration | Separations Style |
Diefault Page Setup  Preview 100.0 [Maone) CMYE Composite
Editi.. Mew... Copy.. | | Delete I Urits: Idpi j
oK | Cancel |
Click on New...
e The New Page Setup window opens.
— Output Device — Resolution
Deviee: |Platswiriter 2488 1 bit Double  ~| [ [ Units:
Configure device. .. | IEBBD.D « 28800 j Idpi j
ProafFeady: I j v Overide resolution in job

— Separations, Screening & Color — Praceszing

Style: | j E| Oiptirization: INone 'l
Colar: I j Eﬂ| Evporsure: I

— Trapping
I ethad: [Maone) - Configure... I [” Enable Feature
Ereferences: I j | Eﬂ I J
— Calibration & Dat Gain —Effects e
1
Calibration: I j b Site
. m| @ 1 irrarprint
Bl I[N il j ™ Cartral strip
Irtended Fress: | j
Ratate: I ] - l
Actual Bress: I j Ol
— Cassette & Page —Scaling
Eazsette: I j %|
‘Vertical: |1 0o0.oo *
FPage layout... |

et I[None] j E| Harizartal: |1 00,00 2

Accelerate... | Optiohz... | FOF Optionz... | SaveA‘f_:.. I Cancel |

¢ In the Output Device section select the device PlateWriter2000 and check that the
values in the Resolution section change to 2880.

* Click on the Configure Device button in the Output Device section.
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* The configuration window for the PlateWriter 2000 opens.

iCtP PlateWriter2000 Series Plugin (Dealer) Configuration 10l =]

Flotter Media
s 1
@l IPIateWriterEDDD j Media thickness & 0.1 mm) I
Drying tirne (Seconds) ID
= | Ic:\
Drying time (Head Pass) IU
Uni-directional [ Wacuum |1UU
Weave adjust I 0 Feed adjustment I 0
= |4
% inking thalftones) | 70 Flaten Gap (0-4) I
% inking (salidsy | 70 Adjusttop margin : I 0.0000
Eject Adjust left margin : I 0.0000
———— Cchoosed Brint Heads
i E.0000
I Cch I Ch 2 ch3 | ch4 | Maintenance Cyole (Hours)l
2007:11:22 17:46 -
Chs | ChE | ch7 | cha | Give more time to Windows v -
CtP

Antidliasing (4 tone and DEEDS early screening only) [Mone j Cancel | m

* Make following settings:
Set Uni-directional

Don’t make any changes to the settings

¢ Click OK to continue.

» Note that the symbols next to the Media names will show as red exclamation marks
until the device is set up. Once you have saved these settings and saved your Page
Setup, if you return to this dialogue box, you will see that these have changed to
green ticks as shown.
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 In the Separations, Screening & Color section of the New Page Setup window
choose a Style — “Separations (CMYK+Spot)” was the one we created earlier, or se-
lect it from the pre-defined Separations Styles loaded when printing the config.ps

file.
ﬂ
— Dutput Device — Rezolution
BETTCR| Platehfriter 2488 1 hit Double Units:
Eonfious cenie | [6e00428800 =] [doi =]
ProofFeady: I j v Overide rezolution in job
— Separations, Screening & Color———————————— ~ Processing
Style: ISeparations [CMYE + spot) j I‘ml Dptimizatiar: INone j
Calor: I[ND Caolor M anagement] j ml Sn I
— Trapping
td ethod: [Mone] - Configure...l I~ Enable Feature
Freferences: | I J
— Calibration & Dot G ain — Effects -
s MNegati
Caliration:  [24881 biD 2347371 7] | \ o
e @ [~ Minorprint
Tane Curves: M o
I[ 4] J [~ Contral stip
Intended Fress: I[Eommermal.&] j Flotate: m
Actual Press: IEurc-pean Gain j e
— Cazzette & Page —Scaling
[Fagsefte: I j @l
Wertical: 100,00 %
FPage layout... |
ﬁl Harizantal: I'IDD.DD 4
|rmposition: I[None] j m RUERS
Socelerate. | Options. .. | FDF Options. .. | Save fs. I Cancel |
e

¢ If you did not print the config.ps file, then leave the fields in the Calibration & Dot
Gain section blank, and follow the procedure described in “Calibrating” later in this
chapter.

o If you did print the config.ps file then,
— Set Calibration to PW2000_371/219
This provides a linear output on the Plate

* Set Tone Curves to None

— Set Intended Press to Commercial A, or another curve that matches your request.
As CTP equipment is generally calibrated to provide a linear press sheet, this adds
back the gain normally expected by conventional printing presses and thus creates
a richer output for 4 colour work than a linear press sheet would.

— Set Actual Press to European Gain or another curve that matches your request.

— This linearizes the output on the press sheet, thus compensating for individual
press characteristics and the effect of the DEEDs screening.
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e The New Page Setup screen should now look like this (if the config.ps file was
printed, otherwise each of the Calibration & Dot Gain items are set to None.

New Page Setup P x|

— Output Device — Rezalution
Dievice: Urits:
EDI"IHQUI’E device... | |2BEUD w 2880.0 j |d|:'| j
PraotFeady I j W Dveride resalution in job
— Separations, Screening & Color———————————  Proceszing
Style: ISeparations [CMYE. + spoat) j ml Dptimizatiar: INone j
Caolar: I[Nc- Color M anagement] j ml e I
— Trapping
t ethod: [Mone] x Configure...l I~ Enable Feature
Ereferences: | I J
— Calibration & Dat G ain — Effects -
fa Megative
Calibration: 24831 bitD 234/371 = | , :
e | [~ Minorprint
Tane Curves M o
I[ ol J [~ Contral stip
Intended Press: I[Commelcial A j B m
Actual Prezs: IEurc-pean Gain j W it
— Cassette & Page —Scaling
[Cassette: I j %l
Wertical 100,00 %
Page layaut... |
ﬁl Harizantal: |1DD.DD %
Irmposition: I[None] j m LSS

Socelerate. | Options. .. | FDF Options. .. | Cancel |

¢ In the Cassette & Page section click the Page Layout.. button to open the Page Lay-
out window.

Page Layout . _'__ ) il

" o N Device Width [0 18.07
Device Length [DIL]: 40,00

Media Size: IDthel vl
edia width [ |1 339
Media Length [L]: |1 9858

i ——
Top argin [TH]: 1.57
v Center page on Media 'width
Battann Margin [Bk]: 055
" Center page on Media Length
Left Margin [Lk] 0.33
Page size: IDther j Right k4 argin [RM]: 039

Page width: |12.EE| Iinches j Select urits: Ii”ChES jv
Page height. [17.72 Y Cancel |

e Select units (inches or mm) for media size and margins.
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Setting the Plate Size
x|

——— D ——H Dievice 'width [Dhw]: 431,80
"
Device Length [DL]: 1M E.00

tedia Size: IUther VI
tedia ‘Width [MWw]: 459,00
tedia Length (L] |525,DD

——t—
Top Margin [TH]: 114,00
[~ Center page on Media width
Bottom b argin [ER]: 114,00
¥ Center page on Media Length
Left Margin [Lk]: IBD
Page size: I;.‘._4 j Right b argin [RM]: 248,94

Pagewidth: [210.06  [millmeters =] | Select units [ilmeters ]
Page height: [297.00 Cancel |

 For printing plates set the Media Width and Media Length to the width and length
of your printing plates. Most plates will be imaged in portrait on PW2000. For exam-
ple, for a Heidelberg SpeedMaster 52 set Width to 459 mm and Length to 525 mm.
* Make sure that the plate will fit on the printer in the orientation you are defining.

* If the Page Setup is for proofing set the Media Width and Media Length to the
width and length of your proofing material. Note that this will generally be a differ-
ent size than your printing plates.
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Setting the Gripper and Job Position on the Plate

Not all of the plate can be reproduced. Furthermore, to reduce press make ready time,
it is desirable to place the job at the same starting point in terms of height, and in the
centre of the width of the plate. As all presses have an area at the top of the plate
where some of the plate is placed in the gripper, you should first establish where on

the plate you want your jobs to start. This is sometimes known as the Gripper Offset
or Top Margin.

Setting the Gripper and Job Position for Landscape Printing Presses

“Gripper Offset” or “Top Margin”

Job positioned
“Centre on Media Width”
|

% Maidman’s Maidmans

<¢—— Media Length ———p»

Centre of Plate Width

Media Width ———————>|

For Landscape presses, where the plate is printed in portrait, the PostScript or pdf-file
will generally be centred on the Media Length, and the Left Margin will be the
Gripper Margin plus the plate bend.
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x

—DU—¥ Device Width [Dw]: 431,80
Device Length [DL]: 101600

tedia Size: IUther vl
tedia Width [ 459,00
tedia Length [ML] |525,DD

——t—
Top Margin [TH]: 114,00
[~ Center page on Media width
Battarm bargin [BR]: 114,00
¥ Center page on Media Length
Left bargin [LAd]: ISD
Page size: |;.\4 j Right b argin [Fb4]: 249,94

Pagewidth: [21006  [milimeters =] | Selest units [illeters 7]
Page height: [237.00 et |

Example of a Heidelberg SpeedMaster 52:
* The plate is loaded portrait (the long edge fits into the gripper).

¢ The plate size is 529 mm x 459 mm, so set the Media Width to 459 mm and set the
Media Length to 525 mm as shown above.

e Then check the Centre page on Media Length box (this places the job, irrespective of
size, in the centre of the plate Length) and ensure the Centre Page on Media Width
is not checked.

* Finally the Left Margin box will be available for you to enter the position that you
want the image to start (the gripper margin) from the top plate edge to the start of
the job.

e Both the Top Margin and Bottom Margin boxes will be greyed out, as the job will
automatically be centred by the RIP.

The Page Size in the bottom left of the dialogue box, will be overridden by the
page size of the job being sent down from your application, so the value here
is not important, however we recommend that you set it at the largest job size
you are ever likely to send to this plate.

0749
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 Click OK to return to the New Page Setup window.

x
— Dutput Device — Resolution
Device: Flatewiiter 2488 1 bit Double ¥ | [5] Urits:
Configure device. .. | |2SSD.D w 2RE0L 0 j Idpi j
ProofReady I j W Overide resolution in job
— Separations, Screening & Color———————————— ~ Processzing
Style: I j m | O ptimization: INQne j
Celar I j El| Exposure: I
— Trapping
I ethod: [Mane] ¥ Laonfigure... | I™ Enable Feature
Freferences: I j | [u I J
r— Calibration & Dot Gain r— Effect -
Megati
Calibraticn: I j Iy el
S J ml @ [ Mirarprint
arie Curves: M >
I[ L] [ Contral strip
Intended Fress: I j Fai m
fictual Press: I j Ol
— Caszette & Page —Scaling
[Eagsette; I j @l
Wertical: I'I 00.00 %
Page lapout... |
ﬁl Harizantal: I'IDD.DD e
Imposition: I[None] j m S
Accelerate, | Options... | FLF Dptions... | Save AT_:.. I Cancel |

Click the Save As... button.
¢ In the appearing Save Setup dialogue...

Save Setup

Default Page Setup
GT052 Pre-5Seperated

GTO52 In-RIF Seperations

ABDick 9810 Pre-Seperated
ABDick 9810 In-RIP Seperations
(K46 Pre separated

Gk 4E In-RIF Separations

SM52 Pre-Seperated

GTOS2 InRIF Se

Save As

erations

Caticel |

...give your Page Setup a name which reflects the press size, and if necessary the
Separations Style so it will be easy to select later. Click the Save button.
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x

RELE] | Device | Riezolution | Calibration | Separations Style |
Default Page Setup  Preview 1000 [Mone] CHMYE Composite
GTOS2 Pre-Sepera...  Platetriter 248, 28800 Pw2000..  Pre separated
GTO52 In-RIP Sep... Plate'winter 248, 28300 Prf2000...  Separations [ChYK)
ABDick 9810 Pre-5... Plateriter 248 28300 Pe2000..  Pre separated
ABDick 9810 In-RL..  Platehwiiter 248, 28300 Pw/2000...  Separations [ChvE)
Q4B Pre separated  Platetwiiter 248, 28800 Pw2000...  Pre separated
Q4B In-RIP Sepa.. Plate'winter 248, 28800 Pw2000...  Seperations [ChYE. + spat]
Edit., o | Depie | Units: [opi -

ok, I Cancel |

¢ Click the OK button to exit the Page Setup Manager.

If you click “Cancel” at any point, including to exit the Page Setup Manager
above, then any changes you made or new Page Setups will be lost!

Setting the Gripper and Job position for Portrait Printing Presses

For Portrait presses, the PostScript or pdf file in theory should be centred on the
Media Width, and the Top Margin should be set equal to the gripper margin plus the
plate bend.

“Gripper Offset” or “Top Margin”

. «—— Media Width ———
Job position

“Centre on Media Width”

@
£
]
]

T
o
| =

Job positioned
“Centre on Media Width”

On a rotated plate this is
“Centre on Media Length”
Centre of Plate Width
On a rotated plate this is

s.uewpg
T'#

“Gripper Offset” or “Top Margin”
On a rotated plate this is “Left Margin”

suewpiew

Maidman’s

Centre of Plate Length
<— Media Length ———»

Plate

(¢———— Media Length ——— |

To improve imaging speed plate is imaged at 270° Rotation
Centre of Plate Width
[——— Media Width —————9>

If your plate size allows it, in many cases it will be quicker for the PW2000 to print the
plate in Landscape orientation due to the fact that the plate has less far to advance.

In this case, the PostScript or pdf file should be set to centred on the shortened Media
Length, and the Left Margin will be set to the gripper plus the plate bend on the
printing press.
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x

—DU—¥ Device Width [Dw]: 431,80
Device Length [DL]: 101600

tedia Size: IUther vl
tedia Width [ 240,00
tedia Length [ML] IEDE,DD

Top Margin [T} ISI]

—H—¥

¥ Center page on Media width

Battarm bargin [BR]: 208,00
[~ Center page on Media Length

Left bargin [LAd]: B4.97
Page size: |;.\4 j Right b argin [Fik]: 54,97

Pagewidth: [21006  [milimeters =] | Selest units [illeters 7]
Page height: [237.00 et |

» Example of an Heidelberg QM46 press:

 The plate size is 340 mm x 505 mm, and normally the narrow edge (340 mm edge)
would be the grip and so would normally be the top.

* Set the Media Width to a plate length of 340 mm and set the Media Length to a
plate width of 505 mm as shown above.

e Check the Centre page on Media Width box (this places the job, irrespective of size,
in the centre of the plate width) and ensure the Centre Page on Media Length is not
checked.

¢ Finally the Top Margin box will be available for you to enter the gripper plus the
plate bend on the printing press.

» Both the Left Margin and Right Margin boxes will be greyed out, as the job will au-
tomatically be centred by the RIP.
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 Click OK to return to the New Page Setup window.

TS x
— Output Device — Rezolution
Device: |[&E i bit Double Uritz:
Configure dewvice... | |288|J.D 29800 j Idpi j
ProofRead): I j W Dveride rezolution in job
— Separations, Screening & Color—————————— —Processzing
Style: ISeparatinn& [CMYE + spat] j I.-q‘l Dptimization: INone j
Calar:; I[Nc- Colar Management] j ml Epe I
— Trapping
tethod: [Mane] = Configure...l I~ Enable Feature
Freferences: I j | [;l I J
— Calibration & Dt G ain —Effects -
fe Megative
Calibratiar: |2488‘I bitD 234,371 j 3 °
ml @ [ Mimarprint
Tone Curves: I[N o] ﬂ )
[~ Contral strip
Intended Press: I[Eommercial.ﬂ‘«] j Flotate: m
Actual Prezs: IEumpean Gain j W it i
— Cazzette & Page —Scaling
[Lassette: | j %l
Wertical I'I no.an et
FPage layout. .. |
ﬁl Huorizantal: |1DEI.IJD e
Impositian: I[None] j m RUSIS
Socelerate,., | Optiohs... | PDF Optionz... | Cancel |

¢ In the Effects section set Rotate to the required rotation that matches depending on
the PostScript or pdf file and if you have a portrait or landscape press.

e Click the Save As... button.
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¢ In the appearing Save Setup dialogue...

i

Default Page Setup
GT052 Pre-5Seperated

GT052 In-RIP Seperations
ABDick 9810 Pre-Seperated
ABDick 9810 In-RIF Seperations
Ok 4E Pre separated

[M4E In-RIF Separations

SMBE2 Pre-Seperated

Save Ag GTOS2 In-RIF Seperations
Cancel |

...give your Page Setup a name which reflects the press size and if necessary the
Separations Style so it will be easy to select later.

¢ Click the Save button.
¢ In the Page Setup Manager dialogue...

rage setup vanager x

RELE] | Device | Riezolution | LCalibration | Separations Style |
Default Page Setup  Preview 1000 [Mone] CHMYE Composite
GTO52 Pre-Sepera...  Platetriter 248, 28800 Pw2000..  Pre separated
GTO52 In-RIP Sep... Plate'winter 248, 28300 Prf2000..  Separations [ChYK)
ABDick 9810 Pre-5... Platehiiter 248, 28300 Pe2000..  Pre zeparated
ABDick 9810 In-RL..  Platehwiiter 248, 28300 Pw2000...  Separations [C7E)
Q4B Pre separated  Platetwiiter 248, 28800 Pw2000...  Pre separated
Ok4E In-RIF Sepa... Plate'winter 248, 28800 Pw/2000...  Seperations [ChYE. + spat]

Edi..

Eapy.. | Delete | Units: Idpi Yl
ok, I Cancel |

...click the OK button to exit.

If you click “Cancel” at any point including to exit the Page Setup Manager
above, then any changes you made or new Page Setups will be lost!
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Duplicating and Editing existing Page Setups

Overview

One of the easiest ways to create new page setups is to duplicate an existing one and
change the items you require. The most common requirement is to create Page Setups
that match different presses and plate sizes.

In addition to this, you may wish to create a duplicate of an existing Page Setup to
handle jobs created by different sources differently.

For example, one workflow /customer may always supply the jobs rotated by 90° and
so you can create a duplicate Page Setup, simply with the Rotation Page effect
switched on to correct this.

Alternatively, one workflow /customer may supply jobs separated, another may
supply jobs pre-separated. Again, duplicating the Page Setup and simply selecting
different separation styles for each Page Setup easily solves this problem.

Finally, you may find from time to time, you receive jobs that have been badly
constructed, and contain CMYK process inks and multiple spot colour inks. Here again

you can edit the Page Setup to override the separation styles to force all colours to
CMYK.

Editing a PageSetup is easy, but remember that it will alter the Page Setup you
choose to edit. We recommend that you duplicate/copy the Page Setup you
want to base your new PageSetup upon, then change this duplicate and leave
the original Page Setup untouched.

Using “Copy” to Create a PageSetup for a different Plate Size
 Select Navigator -> Page Setup Manager from the NavigatorRIP menu.

-l
Mavigator Edit  Preview Color Output  Fonks
f
Print File. .. Chrlp v
) e 3 s i s |

Page Setup Manager ... I"“ = [’ B W
Conrra 0 ChrlAF reening plugin for Flatelwiiter 6.00a _AJ
Device Manager. .. sereening plugin for Platelwfriter 6.00a

soreening plugin B.00a
Input Controller. .. Chrl+n g plugin for Platet/riter B.00a
Start Inputs. .. Chr+I screening plugin: 6.005

g plugin for Platetw/riter 6.00a
Executive ChrHE Flugin ersion 2.1r1 - Copyright [c] 1338-2003 Global Graphics Software Limited. All Rights Reserved

lugin Wersion 2111 - Copyright ] 1998-2003 Global Graphics Software Limited. All Rights Reserved.
Language. .. pyright (2] 1995-2005 Global Graphics 5 oftware Lbd. &1 Rights Reserved.

; E reserved

ABgNatRcor 141113.1.1 - Copight (5) 2004 Global Graphics Softwre L &l Rights Reserved
Logo w1.7.118.1.1 - Coppright [c] 2004-2005 Global Graphics Software Ltd. All Rights Reserved
Memary Statistics .B0.1.2 - Copyright [c] 2000-2004 Global Graphics Software Ltd. All Rights Reserved.

ht [c] 2002-2004 Global Graphics Software Lid. All Rights Reserved
Quit ChrHg 1.1.2 - Copyright [c) 2004-2005 Global Graphics Software Ltd. All Rights Reserved.

= F-ready)
Serial number. 25177-52
4 » 4

0749 Operating Manual - PlateWriter™ 2000



Using the RIP
Creating Page Setups for Plate-making

4-23

ﬂ If you already have a Press Setup created, and you wish to add another of a

different size, then try to select a Setup with the same orientation (e.g. if you
have a Portrait Press setup such as an Heidelberg QM46 and want to create a
different size such as a ABDICK 9810) and copy this Page Setup. This will
make creating the Page Setup much quicker as the only items to change will be
the Plate Size and the PageSetup Name.
Even if you do not have the correct Press orientation already created, it will
still be much quicker than creating a New Page Setup, however you will need
to check you have centred the image on the height (for Landscape) or the
length of the page (for rotated Portrait) appropriately (see section on creating
Page Setups).

¢ In this example we will add a Heidelberg SM52 press (459 mm x 525 mm) to our
Page Setup list by copying and editing the Heidelberg SM GTO52 Page Setup.

e From the list in the Page Setup Manager dialogue...

Page setuprmanager 5I
MHame | Device | Fesolution | Calibration | Separations Style |
Diefault Page Setup  Preview 100.0 [Maone) CMYE. Composite

Platetafriter 248

GT052 Fre-Sepera... 2880.0
GTO052 In-RIF Sep... Platelwiiter 24 20,0
ABDick 9810 Pre-5... Plate\river 248, 28800
ABDick 9810In-R1... Plate\writer 248, 28800
(k4B Pre separated  Platehwiiter 248 2880,0
QM4E In-RIP Sepa.. Platebwiiter 248, 28800

.. Pre separated
... Separations [CMYE)
... Preseparated
... Seperations [CMYE + spot]
.. Pre separated

.. Seperations [CHYE + zpot)

Edit... Mew... Copy... | | Delete I Units: Idpi j

% 0K | Cancel |

...select the Page Setup you wish to base your new Page Setup upon, in this case se-
lect the GTO 52 Pre-Separated Page Setup and click Copy... to create a duplicate
Page Setup.

Operating Manual - PlateWriter" 2000 0749



Using the RIP

Creating Page Setups for Plate-making

e The New Page Setup window will appear.

New Page Setup x|
— Output Device — Rezolution
Device: |[&E i bit Double Uritz:
Configure dewvice... | |288|J.D 29800 j Idpi j
Frootheady: I j IV Dverride resclution in job
— Separations, Screening & Color—————————— —Processzing
Style: ISeparatinn& [CMYE + spat] j I.-q‘l Dptimization: INone j
Calar:; I[Nc- Colar Management] j ml Epe I
— Trapping
tethod: [Mane] = Configure...l I~ Enable Feature
Freferences: I j ?ETB-!' I J
LhF
— Calibration & Dt G ain —Effects
[~ Megative

[~ Contral strip

Raotate: IEI 'l

Calbration:  [2488 1biD 234371 x| :
ml @ [~ Minarprint
Tone Curves: I[N o] ﬂ

Intended Press I[Eommercial.ﬂ‘«]

Actual Prezs: IEumpean Gain j W it i
— Cazzette & Page —Scaling
[Lassette: | j %l
Wertical I'I no.an et
FPage layout. .. |
*

Imposition: I[None] j El Harizankal: I'I 00.0o0

Socelerate,., | Optiohs... | PDF Optionz... | Cancel |

Click on the Page layout... button.
* In the Page Layout dialogue...

x

" o ) Device Width [Cw'T: 43180
Device Length [DL]: 101E,00

Media Size: Il:lther vl
Media Width [Mw]: |459,DD
Media Length [ML]: |525,DEI

i
Top Margin [TM]: 5280
[ Center page on Media width
Bottom kargin [Bk]: 5280
v Certer page on Media Length
Left Margin [LM]: |3U,UU
Page size: |A3 j Right b argin [Rr]: 132,00

Page width:  [297.00  [milimeters x| | Selectunits [milmeters ]
Page height. [420,00 ok | Cancel |

..edit the existing Media Width and Media Length settings to reflect the plate size of
your new press page setup.

In this case plate width is 459 mm and plate length is 525 mm.

Set the new Left Margin if this press has a different Gripper requirement.

Click OK.
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— Output Device

Device: |k jter 2 bit Diauble

Configure device...

ProofFeady: I

Creating Page Setups for Plate-making

* You will be returned to the New Page Setup window.

New Page Setup - x|

r— Rezolution

Units:

[2s800x28800 7| a7

v Overiide resolution in job

— Separations, Screening & Colar———————————————

Style: ISeparations [CMYE. + spot)

= [

— Processing

Optimization: INone 'l

Caolar: I[No Color Management] j m| s I
— Trapping
Method: [Mone] X Canfigure... | I”" Enable Feature
Freferences: | j | {;il I J
 Calibration & Dot Gain r Effects -
Megative
Calbration: ~ [24881hitD 2300371 = | B ’
m| @ [ Mirrarprint
Tane Curves: M x
I[ 2e] J [ Contral stip
Intended Press: |[Eommercial &) j Rotate: m
Actual Press: IEuropean Gain j W T
— Cazzette & Page — Scaling

Cassette: I j %|
Wertical |1 00.00 E4
FPage layout... |
Fopasiiin I[None] ﬂ E| Horizartal: |1DD.DD %
Lrocelerate, | Optionz... | FDF Options. .. | Save fz I Cancel |

lom

Click Save As... to save your new Page Setup with the new plate size.
» Give your new Page Setup a name to reflect the setting you have selected.

x

Default Page Setup

GT052 Pre-5eperated

GT052 In-RIP Seperations
ABDick 9810 Pre-Seperated
ABDick 9810 In-RIP Seperations
(M 4E Pre zeparated
(IM4E In-RIP Separations
SMB2 Pre-Seperated

5 GTOS2 In-RIF Seperations
Save As GTO52 In-RIF ration

Cancel |

In this example name the Setup SM52 In_RIP Separations. Click Save.
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* In the Page Setup Manager dialogue...

Page Setup Manager E ﬂ
Hame I Device I Fezalution I Ealibrationl Separations Style :I

GTO52 Pre-Seperated Plate\wfriter 248, 28800 Fws2000... Pre separated

GTO52 In-RIP Seperations  Platelw/riter 248, 28800 Faf2000.,.  Separations [Chivk)
ABDick 9810 Pre-Seperat...  Platelwfiter 248 2880,0 Fws2000... Pre separated

ABRDick 9810 In-RIF Sepe... Platetw/friter 248 2880,0 Fw/2000... Seperations [ChYE +
Ok 4E Pre separated Platetafriter 248, 28800 Fw2000... Pre separated

LMAE In-RIP Separations  Platedwfriter 241 PwW2000... Seperations [CMYE +

Sh52 In-RIF Seperations e _.. .. Separations [Chivk]

Edit... | Mew... | Capy... I Delete | Urits: Idpi 'I

Qg | Cancel |

...verify that your new Page Setup appears in the list.
Click OK to exit.

If you click “Cancel” at any point including to exit the Page Setup Manager
above, then any changes you made or new Page Setups will be lost!

* You have now completed creating your new Press Page Setup.
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Printing a Job Using the RIP

Using the Print File Command

When you select Print File from the Navigator RIP menu, the dialogue box shown
below appears.

Laak i I |23 Print Jobs j R = E2-
(=L Frostfire T 105-0473_DG_Ttalian
- Frostfire both Ihd T 105-0675_MikeSutcliffe
= Hamer leaflet T 105-0834_SP5_xE7_FOL
% Highclere leaflet T 105-0834_5P5 _x57_F02
= intermusic T 05-0834_5PS_x57_F03
Z Inkermusic Folder Z Martch Patrment Request
< | i
File name: |Frostfire bath Ihd -
Frint I
Files of bype: i les " ps:* hd
by IF'ostSc:npt and POF Files [* ps:” pdf) J Cancel |
Page Setup: | Default Page Setup j
[efault Page Setup

ABdick 3810 Pre-seperated
ABRdick 9810 In-RIP seperations
[3T[] b Fre-Seperated

GTO 52 In RIP Sepserations

Ensure you choose an appropriate Page Setup for printing the files, from the Page
Setup drop-down list.

If you do not choose a Page Setup, the RIP uses the one that you chose last
time you printed a file. If you have not printed a file in this RIP session, the
first Page Setup in the drop-down list is used. To change the order of this
listing, simply drag the PageSetup you want at the top of the list into that
position in the PageSetup Manager. See full RIP manual page 118 for further
details.

The Print File dialogue box shows all PostScript-language and PDF files in the current
folder. To show files of a different type, or all files, use the Files of type drop-down
list.

If you want to choose a file that is not in the folder shown, use the dialogue box to

navigate to the correct folder.

To select all files in the list, click anywhere in the central list of files and type
Ctrl+A.

While any file is being processed, an additional Print File menu appears on the menu
bar of the main RIP window.

You can abort the current job by choosing Kill Current Job from this menu, or by
typing Alt+ (a period character).

When Kill Current Job is selected, the current job is stopped, but subsequent jobs will
be processed.

By selecting Stop Printing File, the current file will complete, but any jobs queued
after the current job will not print.

Selecting Abort Printing File will stop the current job and also stop all subsequently
queued jobs from ripping.
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Printing several files

To print out several files at once, just select more than one file from the Print File
dialogue box before clicking Print.

The following keys make this possible:

You can select a contiguous block of files by selecting the first file in the block, then
selecting the last file in the block while holding down the Shift key.

Citrl

You can select several non-contiguous file names by holding down the Ctrl key while
making your selection.

The list of files to print can include files other than PostScript-language, PDF
files, TIFF 6.0, and TIFF/IT-P 1. The RIP ignores types of files that it cannot
print.
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Automating Job Input to the RIP

Printing using Managed Input Plug-ins or 'Input Queues'

This section describes the different ways in which the Navigator RIP can accept input,
and how to configure the RIP to use each type of input.

There are several ways of providing input to the Navigator RIP:

 Using the Print File menu command, as described previously.
This command allows a user on the machine running the RIP to print all of the job
types possible on that installation of the RIP. You can use Print File while managed
inputs are active.

» Using one or more managed inputs, as described below, and the following sections.
This is the preferred method for routine use because, in general, the managed inputs
allow users on many machines to submit jobs to the RIP.

When you use managed inputs or the Print File menu command, you can print several
types of job.

The possible types, are:

 PostScript-language files (PS) and Encapsulated PostScript files (EPS)
Portable Document Format (PDF) files.

JPEG and JFIF files.

TIFF/IT-P1 files.

TIFF 6.0 files.

In the same way that the RIP uses output plugins to provide output sources such as the
PlateMaker or Proofer, it uses Input Plug-ins to provide managed input sources.

There are a number of input plug-ins supplied with the RIP, each providing you with
the ability to submit jobs under different situations.

The full Xitron RIP manual describes all of these plug-ins, and the way in which you
can manage the inputs they provide. This manual only covers the most frequently used
plug-ins, what they do and how to set them up.

The most commonly used inputs are:
* Spool Folder (also known as Hot Folders, or watched folders)

This lets you specify multiple independent folders into which users or applications
can place jobs to be printed. The RIP checks for the presence of files in these folders
and prints each one automatically.

Folders can be shared across a network, however Apple Users will only be able
to see PC networks if the Network has been configured with the additional
ExtremeZ-IP protocol provided or with SERVER based applications. The
Normal mode of connection for Apple users is to use the AppleTalk plug-in
detailed below.
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e AppleTalk

This publishes PageSetups in the RIP as a printer(s) on AppleTalk networks and lets
the RIP accept input from any Mac application that prints to the printer(s) broadcast
by the RIP.

e NT Print

This publishes the RIP as a printer available to the Windows NT print services, this
printer can then be shared to other PC users in a similar fashion to the AppleTalk
plug-in for Mac users.

Each of these plug-ins can have multiple configurations, each configuration is given a
unique name, then the input derived from the queue is linked to a specified Page
Setup, so the RIP can print the file. This enables multiple Inputs from different sources
for each page setup, and/or one input plug-in to receive jobs for multiple Page Setups.

Example: A print queue may be set up watching a specific folder (using the Spool
input plug-in), any files sent to this folder will be delivered to the page setup
associated with this print queue (such as PageSetup 1).

At the same time, an addition queue may be active, using the AppleTalk input
plug-in, a print queue can be created which broadcasts a “virtual” printer on an
Apple Network. Any jobs printed by a Mac user will be delivered to the page setup
associated with this Print Queue (which could also for this example be PageSetup1).

Therefore, in this scenario the RIP allows different inputs (both AppleTalk and
SpoolFolders) to send jobs to the RIP and will automatically accept and handle them as
they arrive.

Alternatively: A Print queue may be set up watching a specific folder (e.g. folder
QM46) using the spool input plug-in, any files sent to this folder will be delivered to
the page setup associated with this print queue (such as a PageSetup for the
Heidelberg QM46 press).

At the same time, an addition queue may be set up watching a different specific
folder (e.g. folder GTO52) using the spool input plug-in, any files sent to this folder
will be delivered to the page setup associated with this print queue (such as a
PageSetup for a Heidelberg GTO52 press).

Therefore, in this scenario the RIP allows multiple folders to be published on a
network, and users can drag and drop jobs/files into the folder relating to the
appropriate page setup. The most common example of this is to accept jobs for
different press sizes, so the RIP can orientate the job for each press, set the grip
position and then output the job.
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Managing Input Plugins

You control input plugins using the Input Controller. Before creating new inputs or
changing existing ones, check that you have an appropriate page setup which can be
associated with each input.

e Open the Input Controller dialogue box either by choosing the NavigatorRIP -> In-
put Controller menu option or by clicking the tool bar button.

Y

 The following Input Controller dialogue box will appear.

:’alnput Controller |
M armne | Type | Fage Setup | Enahlel Status |
SpoolFolder SpoolFolder  Default Page Setup On Stopped
M avigator AppleT alk, Default Page Setup On Stopped

[T Show protected channels

Edi | New | Copp | | Dl | on | o |

The Input Controller dialogue box shows the input sources currently available. Each
input source can be turned on or off individually using the buttons— the state is dis-
played in the Status column.

Each row in the list represents one particular source, and contains:

— The Name for the input source. This is used to identify the source within the RIP.
It may also be used by the input plugin itself.

— The Type of input. This determines which input plugin the RIP uses.

— The Page Setup. This is the page setup used by all jobs arriving through this
source.

— The Enabled state. This should be On to make the source available when you start
the RIP or start inputs.

— The Status. This can be Stopped, Idle, or Busy.

An input is stopped either because all inputs are stopped, because you have disabled
this input in the Input Controller (using Off), or because of a problem when trying
to start that input. An idle input is ready to receive a job but none is arriving. A busy
input is actually receiving a job.

Below the list of sources are several buttons that allow you to perform the various
actions enabling you to create, copy or delete managed inputs.

When you have finished making changes in the Input Controller, you can keep it
visible as a way of monitoring which inputs are submitting jobs or close it either by
using the Navigator RIP -> Input Controller menu option or by clicking the tool bar
button.
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Turning on the input system

To start receiving jobs from the configured and enabled inputs, choose the
NavigatorRIP -> Input Controller menu option or clicking the tool bar button.

The tool bar button is the most frequently used way to start or stop the queues, and
simply uses icons representing Traffic Lights.

Click the Green Traffic Light to start the queues, and the Red Traffic Light to stop the
queues.

When you start the Queues, there is a delay of a few seconds as the various
defined input sources are initialized, and then the RIP starts to accept jobs
from those sources.

The status area of the tool bar shows the searching for input symbol (a torch or
flashlight shining on an arrow).

A new menu appears in the menu bar, called Input Queue.

This menu has these options:

¢ Kill Current Job: This causes the job currently processing to be aborted. It may take
a few seconds.

o Stop Input Queue: This turns off the input system when the job currently process-
ing has finished.

e Abort Input Queue: This aborts the job currently processing and then turns off the
input system.

Adding a new input source to the list

You can create many different input sources for each input plugin. For example, you
could create 5 spool folder input sources and 10 AppleTalk input sources.

To add a new input source to the list:

¢ Click the New button in the Input Controller window. The RIP displays an Input
Channel Edit dialogue box, allowing you to fill in the details for this source.

Input Channel Edit Ed |

M ame: IF'Iates for Heidelberg GTO :
Canfigure
Type: | &ppleTalk |
ak.
Fage Setup: : ]
v Enabled Cancel
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* Type a name for the Input plugin device in the Name text box.

The name is used to identify the source within the RIP. It may also be used
by the input plugin itself. If you create an AppleTalk input device, when
you start the inputs a ‘virtual printer’ with this name becomes available on
the AppleTalk network. Try to use names that allow you to identify which
PageSetup the jobs will be sent to.

e Choose the plugin type from the Type drop-down list. (e.g. AppleTalk, or Spool
Folder)

» Choose a saved page setup from the Page Setup drop-down list. The RIP applies
this page setup to each job arriving at the source.

o If the plugin is to be initially turned on, select the Enabled check box.

* Click the Configure button to display an Input Plugin Configuration dialogue box,
allowing you to specify details relevant to the input plugin you have chosen.
The Configuration dialogue box varies according to the type of plugin chosen. It is
used to give details about how the input is to be handled, e.g. for Spool Folders, it
tells the RIP which folder to watch for jobs. See below for the configuration and use
of this box.

* When you have specified all the details for the new source, click OK.

Copying an input plugin

When you have created an input plugin, you can copy it to create other inputs of a
similar type. This can save you some effort, depending on the complexity of the
Configuration dialogue box.

To copy an existing input, select the entry in the Input Controller and click the Copy
button.

You must give the copied input a new name and you will probably need to alter some
details in the Configuration dialogue box. For example, only one active input can use a
particular spool folder or network input at one time - but you can have two or more
inputs using the same source, provided that you enable only one at a time.

Editing the details for an input source

To edit the details for an existing input source, do one of the following:
¢ Select the entry in the Input Controller and click the Edit button.
e Double-click the entry in the Input Controller.

The RIP displays an Input Channel Edit dialogue box, allowing you to edit the details
for the selected plugin.
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Configuring an input plugin

Configuring an input means giving details about how the input is to be handled, and
setting up any hardware or software associated with the source. To configure an
existing input plugin, select it in the Input Controller and click Edit.

The RIP displays the Input Channel Edit dialogue box. Click Configure to see the
Configuration dialogue box for the selected input.

Deleting an input source

To delete an input source from the RIP, select it in the Input Controller and click the
Delete button. You can select multiple inputs and delete them in one action.

Enabling and disabling input sources

To enable an input source, select it in the Input Controller and click the On button.
To disable a source, select it and click the Off button.

Using these buttons has the same effect as selecting or clearing the Enabled check box
in the relevant Input Channel Edit dialogue box.

When the selected input source is enabled, then the On button is disabled, and when it
is not enabled then the Off button is disabled.

You can select several input sources and then turn them on or off together.

When an input plugin is enabled, the RIP automatically publishes it when starting
input queues, meaning that the input plugin can be used to send jobs to the RIP.

To make enabled inputs active, choose NavigatorRIP -> Start Inputs or click the
Green Traffic Light tool bar button.

To stop all enabled inputs, choose NavigatorRIP -> Start Inputs again or click the Red
Traffic Light tool bar button.

0749
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Using the Spool Folder Input folder

The spool folder input is the most popular managed input for PC users. The Spool
plug-in regularly scans a specified disk folder (directory), and processes any
PostScript-language files (and other suitable files) that are placed there. Normally these
files are deleted after successful processing. The spool folder can be on a network file
server, or the local iCtP RIP Workstation. Users create files from their applications.
These applications can create the files directly in the spool folder, or can create them
elsewhere (for example, on the local system) for later transfer into the spool folder.

The RIP can process some or all of the following file types using a spool folder:
 Post-Script-language (PS)

e Encapsulated PostScript (EPS)

Portable Document Format (PDF)

TIFF 6.0

JPEG and JFIF files

The RIP ignores types of files that it cannot print, and any files that you exclude
intentionally by configuring the spool folder input.

You can exclude files based on their names. You may want to exclude files that
resemble real jobs, but that actually contain accounting or housekeeping information
for the software that delivers files into the spool folder. You may also want to exclude,
or at least delay, real jobs with particular origins or qualities. All this is possible so long
as the file names have a recognizable prefix.

You specify which folder the RIP uses in the input plugin Configure dialogue box,
available from the Input Controller. If needed, you can create several spooled inputs,
each with its own folder, page setup, and exclusion list.

When you specify a folder accessed over a network, make sure that the folder
automatically becomes available to the computer running the RIP when that computer
is restarted. Because files are normally deleted as soon as they are printed, it is
important to ensure that the RIP has permission to delete files in the spool folder,
particularly if the spool folder is on a network file server.

The files in the spool folders are processed in the order in which they arrive. However,
if there are jobs already in a folder when the RIP is started, or if a very large number of
tiles have been queued, the RIP determines the order of those jobs by the date stamps
on the files.
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Creating and Configuring a Spool Folder Input Source
To create and configure a new spool folder source do the following;:
* Open the Input Controller dialogue box either by choosing the NavigatorRIP -> In-
put Controller menu option or by clicking the tool bar button.
* The Input Controller dialogue box will appear.
T e |
Mame I Type I FPage Setup | Enablel Status I
SpoolFalder SpoolFolder  Default Page Setup On Stopped
M awvigator AppleT alk Default Page Setup On Stopped
" Show protected channelz
Edt | Mew | Com | | Dok | On il
Click New
* The RIP displays the Input Channel Edit dialogue box.
gt Chamnel et |
Hans I Eonfigure |
Type: -
' =
FPage Setup; I j
¥ Enabled Cancel |
e Choose SpoolFolder from the Type drop-down list.
oput Chammelae K|
Heine I [Eonfigure |
Type: j
AppleTak ok |
Page Setup:  |yT Fipe
@ ey (Sl 2R
Socketlnputdsync
SucketlnEutE!uit
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* Select the Page Setup you wish to receive and process jobs that arrive in the spool
folder (here we have selected the GTO52 Pre-Separated Page Setup).

Input Channel Edit Ed |

Hame: I Configure |
Type: ISpu:u:uIFu:uIder j

B] 4
Fage Setup: j _l

Default Page Setup Cancel
I Enabled ABdick 9810 Pre-zeperateq _l

ABdick 3810 In-RIP zepers
GTO 52 Pre-Seperated o
GTO 52 In RIF Sepzeratiag
Heidelberg MO Pre-Sepera
test

Input Channel Edit

» Give your input queue a Name (try to use names that reflect the PageSetup you are
sending it to, to make editing queues later a little easier).

]|

M ame: |GTI352 Flates [FLDr) .
Configure
Type: I SpoolFalder j
Ok
Fage Setup: IGTIII e Pre-Seperatedj
Cancel

¥ Enabled

Spool Folder Configuration

¥ Create spool folders if they do not exist

W wiamif spool folderz dao not exizt

Xl
Spool Folder | IC:\F‘rogram Filesitron_ 710555 pooly
Error Folder | ICIF‘rogram Files'itron_ 711085/ \ERRORY

[ Delete on emror IMovefDeIete Walid Files

Complete Folder | |E:\Program Files'witror_ 71085 AComplatels

¥ Delete on completion

Filehames prefi list: |

[~ Exclude prefis lizt

Scan spool folder every | 5 zeconds

Tirne b wait for file bo stabilize IT seconds (]4 |
™ Treat TIFFAT files as a single output group Cancel |

[~ Suppress startup warnings

¢ Click on the Configure button to open the Spool Folder Configuration window.
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e The Spool Folder Configuration window contains the following control items:

Spool Folder

The current spool folder is shown in the text field beside this button. This location is
where the RIP detects the arrival of files and considers them as possible jobs, by
looking at the type of file and any file names excluded in the Filenames pre-fix list.

Choose a folder that is dedicated to receiving jobs. In particular, avoid using
folders where other files are arriving or changing (for example, the SW
folder is a bad choice, because the log file changes with every job).

Click the Spool Folder button to change this folder using the standard file browsing
dialogue box.
Select Folder

Current directory: d:hjobs

Files: I“-x

= J0BS
3 Enar Cancel
£ GTO 52 ChYE

2 [ =] K, I
_Carcel |

mm GTO 52 Pre-Sege
LI £ Success k

Metwork. .. |
| |

-

Lizt files of type: Dirives:
J il Files (%) 2| (=40 |

Alternatively you can type a full path name in the text field, but be aware
that any typing errors can cause an error or the creation of a new folder.

We recommend that you create a folder called Jobs, and in there create folders for
each Press and Plate Setup you have created as Page Setups.

In this example, as we have created a Spool Folder queue that sends jobs to the
GTO52 Pre-Separated Page Setup, we have named the folder the same, so when you
drop the files into the folder you will know which Page Setup will be applied to the
job.

Create spool folders if they do not exist:

Select this box if you want the RIP to create the named spool folders if they do not
already exist.

The RIP creates the folders when the input channel becomes available for use. This
time can be immediately after you click OK in the Input Channel Edit dialogue box
for an enabled channel, but you may need to choose NavigatorRIP -> Start Inputs
or enable the input channel before it becomes fully available.

Warn if spool folders do not exist
Select this box if you want the RIP to issue a warning if a folder named as a spool,
error, or completion folder does not exist.
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Error Folder

If a file fails to print, the RIP moves it to the error folder specified unless the Delete
on error box is selected. If a file prints successfully, the RIP moves it to the Complete
Folder specified unless the Delete on completion box is selected.

Again, we recommend you change the default here to a folder called Error inside
your main Jobs folder.

Delete on error
Select this box if you want the RIP to delete files that the Spool folder fails to print.
Leave this box clear if you want failed files to be moved to the Error folder.

We recommend you do not check this box, so that you can check which files
create an error, then you can take at look at them to determine why.

Note that a file is treated as an error if you abort it while it is being processed.

Move/Delete All Files

With this option selected the spool plugin will either move to the Error folder, or
delete any file which it does not recognize (such as badly formed PDF documents).
The files are moved or deleted depending on the state of the Delete on error check
box.

W If you decide to use this option and you inadvertently choose to point the
spool folder at a directory containing important files (such as C: \win-
dows... or your SW folder) you will remove all files in this folder, resulting
in either a non-functional computer or non-functional applications. The
plugin deletes or moves all the files it cannot handle.

Move/Delete Valid Files

In this case, if a file is encountered which the spool plugin does not recognize, it will
leave the file in the spool folder and ignore it. Valid files which cause an error will be
treated according to the setting of the Delete on error check box.

Complete Folder
If a file successfully prints, the RIP moves it to the location specified in the text field
beside this button unless the Delete on completion box is checked.
Click the Complete Folder button to change this location using the standard file
browsing dialogue box.

Select Folder

Current directory: d:%jobs

Files: I

= [ = ok, |
=

= J0Bs
3 Enor Cancel
£ GTO 52 CMYE

£ GTO 52 Pre-Sepe Metwork. . |

List files of type: Drives:
J il Files (%) | [=dDaa =
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Delete on completion
Select this box if you want the RIP to delete files that the spool folder succeeds in
printing. Otherwise the RIP moves these files to the Complete folder.

Generally we recommend deleting jobs after printing successfully.
However, there are circumstances where this is useful, such as moving the
job into another folder for RIPPing, like the Proofing folder. So you can
supply Plates and Proofs at the same time from the same file.

Filenames prefix list

This text field specifies files to ignore when they arrive in the spool folder, if you
have also selected the Exclude prefix list box. The specification is based on the first
part or prefix of the file names. Prefixes are case sensitive.

You can enter several prefixes. Separate multiple prefixes by commas without
surrounding spaces. If you add spaces after a comma, the RIP treats the spaces as
part of the following string. Each prefix can include alphanumeric characters, the
underscore character, the period character, and spaces.

For example, this is a valid list of three prefixes: aaab_c, BAC, 4.4

Exclude prefix list
Check this box to make the prefix list active. Leave this box empty to disable the
prefix list without deleting the list of prefixes.

Scan spool folder every <n> seconds
The value in the text box specifies how often the RIP checks the Spool folder for new
files to be printed.

Time to wait for file to stabilize <n> seconds

The value in the text box specifies the number of seconds that the Spool folder waits
for the size of an arriving file to remain the same before assuming that it has been
fully written and is therefore ready to be printed.

Suppress startup warnings

If you have files present in the spool folder and then start the RIP, you will be
prompted with a warning that files already exist in this folder which you must
acknowledge before the RIP will start. If you would prefer to suppress these startup
warning messages and continue to start the RIP, select this option. All files present
in the folder will be processed.

Having set all the configuration options click OK. Your Input Queue is now ready to
use. If you have now set all the queues up and want to activate them, click the Green
Traffic Light button on the tool bar to start your queues.

If you want to set up multiple queues based upon different page setups,
select the Spool Folder queue that you have just set up, then use the “Copy”
button at the bottom of the Input Manager dialogue box. Then give your
copied input queue a different name, select the new page setup which you
wish to send the jobs to, then click “Configure”. Now you only need to
change the “Spool” folder, to reflect a new folder to act as the source for
your new queue.
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Using the AppleTalk Input Plugin

With the AppleTalk Plugin, the user defines a name and defines a Page Setup from the
RIP to associate to that name (Queue). The name (Queue) is then published by the
AppleTalk input source over the Apple network. This name (queue) appears in the
Chooser on Macintosh computers connected to the network very much like a Laser
Printer (so, in effect the Name/Queue is a virtual printer hosted by the RIP).

When Mac users select this name (Queue) they can then install the “virtual printer”
hosted by the RIP, just as they would a LaserPrinter. Users can create multiple Queues,
each associated with different Page Setups. So, the Chooser will see multiple
“printers”. After this users simply select the Printer relating to the Page Setup they
wish to send jobs to and then print directly from the application they are using.

When jobs arrive from the Mac, the RIP detects which “virtual printer” they were sent
to, applies the associated Page Setup and processes the job accordingly.

Configuring an AppleTalk input source

e To create an AppleTalk input source, select the source in the Input Controller and
click New. The RIP displays the Input Channel Edit dialogue box.

Input Channel Edit |
M ame: IF"Iates for Heidelberg GTO ;
i [Eanfigure
Type: i j
I ]
Page Setup: I j
¥ Enabled Cancel

Enter a Name for your Queue.

As this name will be broadcast over the AppleNet work to identify your
queue (and will essentially appear as a printer in the chooser) select a name
that clearly identifies the Page Setup the job will be sent to.

For example for the Page Setup GTO 52 Pre-Separated you could set the Name to
“Plates for Heidelberg”. Or if you have a proofer, you could set the Name to Proofer.
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o After you have entered the name, select AppleTalk from the drop down menu in

the Type box.
Input Channel Edit I
M arme: IF'Iates for Heidelberg GTO ;
Configure
Type: MT Pipe j
I ]
Fage Setup: [T Fipe
Sernal lnput Cancel
IV Enabled Socket nput

Socket nputdeync
Socket nputCuit
SpoolFolder

The AppleTalk Input Plugin is one of the simplest to set up, and there is nothing that
needs to be configured for this plugin, so you can now click OK and the plugin is
ready to use.
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Using the NT Print input

This input publishes the RIP as one or more printers available to the Windows NT,
2000, and XP print services. Once fully installed and configured, each printer has a
name visible to Windows operating systems.

There are several stages to installation and configuration, which you must carry out in
the following order:

¢ Installing the plugin
» Configuring the RIP to make the input available
e Configuring Windows to associate a printer with the RIP input

Installing the plugin

When your RIP was installed, the installer placed the NT Print plugin install wizard in
the C:\Program Files\Xitron_7.1rO\NTPrint folder.

Use the Installation Wizard as described below:
* Exit all running applications
e Run the file Setup.exe found in the \Ntprint folder

* When the installation program asks you, choose the folder in which the Navigator
RIP is installed

MTPrint Plugin Files directory selection

Pleaze specify the directary it which M TPrint Plugin Files is
installed.

Thig iz the directory which containz the S subdirectary.

Tao accept the default, zelect Mest

" [estination Directaory

C:AScrptwiorks

< Back MHemt » | Cancel |
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 Click on Browse and select the folder where your RIP is installed.

Choose Directory ] x|

Please choose the directory for installation.

Path:

I[::'-,p rogram fileskxitron_71r0

Directories:

(== Program Files - 0K

& Xitron F1r0

£3 .manifest

3 AppleTalk

3 Factory Defaults

£3 genlin

£ Messages

£ migrate |

Cancel

Drives: %

| = c: wIN | Netwurk...l

This should be C:\Program Files\Xitron_7.1r0.
Click OK

» Wait for the installation process to finish...

NTPrint Plugin Files Installation [ES

\ ? ) Rehoot the compuker now?
i

Yes | [\E Mo I

...then reboot the computer.

Creating an NT Print Input

Having installed the plugin as described above, you can create a Navigator RIP input.

* Click New in the Input Controller. The Input Channel Edit dialogue box appears.

Input Channel Edit |

i arne: |Heidell:nerg GTOSZ Plates L\\\, Corf
anfigure
Type: I j
[F
Fage Setup: I j
¥ Enabled Eieizs)

Give the input a suitable name.
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e Choose NT Input from the Type drop-down list.
Input Channel Edit |
I arne; IHeiu:IeII:uerg GTORZ Plates i
Configure |
Type: MHT Pipe j

] %
AppleT alk
Page Setup: o —l
v Enabled Rl e Lancel |

Senal [nput
Socketinput
Socket nputdsync
Socketl nputCluit
SpoalFolder

 Select a Page Setup then check the Enabled box.

Input Channel Edit | X |

M ame: |H eidelberg GTO52 Flates

Configyre
Type: INT [t j k

OF.

Page Setup: | 510400 [GT052) Plate > |

[¥ Enabled Cancel |

 Click the Configure button. The NT Print Configuration dialogue box appears.

MT Print Configuration EH

I

|'Startup Rty Configuration L@( I

[~ Enable I 0 Rety Delay [zeconds)

Cancel |

The dialogue box contains controls to allow for the situation where RIP inputs have
started up before the Windows spooler system - this is possible on fast machines.
The default is to accept failure, in which case the printer will be unavailable without
user intervention. You can make the RIP keep trying, within a time limit, by using
the controls.

Enable
Select this box if you want the RIP to retry making a connection to the Windows
spooler after initially failing.

Retry delay
Enter the time, after the initial failure, for which you wish the RIP to continue retry-
ing. A retry delay of 60 seconds is likely to be enough on all machines. Too long a
delay means delaying jobs on other inputs, so reduce this figure if you have no
problems.

 Click OK to close the NT Print Configuration window.

 Click OK in the Input Channel Edit dialogue box to close it.

e Use Navigator RIP -> Start Inputs to start inputs (or the Green Traffic Light icon on
the toolbar).

You now have a RIP channel that forms a port visible to the Windows printer
configuration software. Next you must add a printer under Windows XP.
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Creating a Printer under Windows XP

You have two options. Either you can create a new printer to use the RIP channel, or
you can connect an existing printer to the RIP channel. The procedures are similar for
Windows XP and Windows 2000.

To create a printer for Windows XP:

 Using the NavigatorRIP -> Input Controller, create and start a new input channel of
the type NT Input as described earlier in “Creating an NT Print Input”.

e In Windows, from the Start menu select Settings -> Printers and select Add Printer.
The Add Printer Wizard appears.

Welcome to the Add Printer
Wizard

Thiz wizard helps you install a printer or make printer
conhections.

O If you have a Plug and Play printer that connects
\{) through a USE part [or any ather hot pluggable
port, such az IEEE 1394, infrared, and g0 on, you
do not need to use this wizard. Click Cancel to
cloze the wizard, and then plug the printer's cable
into your computer or point the prinker toward your
computer's infrared port, and turn the printer an.
Windows will automatically install the printer for you,

To continue, click Mext.

< Bach Cancel

Click on Next.

* Select Local printer attached to this computer and ensure that the Automatically
detect and install my Plug and Play printer check box is not checked.

Add Printer Wizard

Local or Network Printer
The wizard needs to know which tepe of printer to set up.

Select the option that descrbes the printer you want bo uze:

* Local printer attached to this computer

H Butomatically detect and install my Plug and Play printer

" & network printer, of a printer attached to another computer

i To zet up a network, printer that is not attached to a print server,
\l) uze the "Local printer' option.

< Back I Mext = I Cancel

Click Next.
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 Select Create a new port and select ScriptWorks from the drop down selection box

(this is the input added to Windows by the Harlequin RIP).
Click on Next.

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports.

Select the part you want pour printer to uze. |f the port iz not listed, you can create a
new pork.

€ se the following port; ILF'T1: [Fecommended Frinter Port) j

Ioter i ost computers uge the LETE port o commuricate with & lozal printer.
The connector for this port should look something like this:

select ScriptWorks Channel Name

Heidelberg GTIDEZ Plates

& [Create a hew part:
Type of port:

I Scriptworks

< Back | Hexl

Cancel

Help

il

A list box is then displayed showing the names of all unconnected ScriptWorks
Channels (that is the name of any input you have created using the NTPrint Plugin).

Select one of these and click OK.

» Configure the printer. To do this you need to install the printer driver for the

PlateWriter2000 supplied on the PW2000 Installer CD.

Add Printer Wizard '

Local or Metwork Printer
The wizard needs to know which type of printer to zet up.

Select the option that describes the printer pou want bo use:

&' |Local printer attached to this computer

[ | Hutomatically detect and install my Plug and Play printes

& metwark printer, o a printer attached to another computer

& To set up a netwark. prinker that iz not attached to a print zerver,
\1) uze the "Local printer’ option.

< Back I Mest > I

Cancel

Click Have Disk...
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¢ Insert the PW2000 Installer CD ROM. Open the Windows Postscript Driver folder.

Lok it I;L"‘)Windows PostSeript Driver j Qe

File name: — [iCTP_w/in2k 4P INF = ﬂl
Files of type: I Setup Infarmation [%inf] j ﬂl
A

Select the iCTP_Win2K-XP.INF file and click Open.
 Click OK.

Install From Disk

Inzert the manufacturer's inztallation dizk, and then
o make sure that the comect diive iz selected below.

Cahce

il

Copy manufacturer's filez from:;

IZ:'\Windows PostScript Driver j Browsze... I

e The iCTP Postscript Driver will be displayed.

Add Printer Wizard

Install Printer Software 0
&

The manufacturer and model determine which printer softvare to use.

3 _\ Select the manutacturer and model of pour printer. If your printer came with an installation
. dizk, click Have Disk. |f your printer is not listed, corsult your printer documentation for
compatible printer software.
Printers |

Windows Updste | HaveDisk.. |

cack [ news I Concel |

/0 This driver is not digitally signed!
Tel me why driver sioning is important

Select it, then click Next.
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Using the NT Print input

* Now you must give your printer a name. By default Windows will use the iCTP
Postscript driver name, however you will want to choose a name, to reflect which
Page Setup the jobs will be delivered to for users using this queue.

MName Your Printer
*fou must assign a name to this printer.

Typs & nisme for this printer. Becauss some programs do not suppor printer and server
name combinations of more than 31 characters, it is best o keep the name as short 3
possible:

Frinter name:
Heidelberg GTO 52 Flates

Do you want to use this printer 2% the default printsr?

 Yes
& No

<Back [ Nest> | Cancal |

Name the printer (we suggest you use the PageSetup name or something close to it).
Click Next.

e Choose whether or not to share the printer (for other Network users to see) giving it
a shared name if you do share it.

Add Printer Wizard

Printer Sharing

“ou can share this printer with other network users, :

IF you want ta share this printer, you must pravide & share name. o can use the
suggested name or type a new one. The share name will be visible to other network
users.

' Do hot share this printer
€ Shars name: |5m52

< Back I Nest > I Cancel

Click Next.
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Using the NT Print input

* Windows will ask you if you want to print a test page.

Add Printer Wizard

Print Test Page
Tao confirm that the printer is inztalled properly, you can print a test page.

Do pou want ko print a test paga?
 Yes
% Mo

s

< Back I Mext > I Cancel |

This is not necessary, so select No and click Next.

* Finally, you will see a Completion screen summarizing the details fo the printer you
have added.

Add Printer Wizard

Completing the Add Printer
Wizard

Y'ou have successfully completed the Add Printer ‘Wizard.
“Y'ou zpecified the following printer settings:

Mame: Heidelberg GTO 52 Plates
Share name:  <Mot Shared:

Part: Heidelberg GTORZ Plates
Model: ICTP PostScript Driver
Defaul: Mo

Test page: Mo I

To cloge this wizard, click Finish.

< Back I Finizh I Cancel |

Click Finish.
» Windows will copy over the files it needs from the CD ROM.

Copying Files... Ed |

LS

REERIFEHER
To C:YND WS S estem32hepoals. . hictp_platewriterd 200

Cancel

* Installation is complete.
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Using the NT Print input e

If you later want to reassign the printer to another port, do this:
e Choose the menu option Start -> Settings -> Printers.
¢ In the Printers window, select the printer, right-click and choose Properties.

e In the Properties window, click the Ports tab. Choose a new port by selecting its box
in the list of ports.

 Click OK to confirm the changes.

Using the Printer from Windows 2000/XP

The new printer is now connected to the RIP. Any printer output sent to the new
printer will be routed to the RIP.

The Windows spooler will remember the names of the printers between reboots of the
computer running the Navigator RIP.

If an attempt is made to send a file to a printer attached to a RIP channel that is
not currently running (i.e. you have launched the RIP but forgotten to start the
Channels) a warning is displayed in Windows that the port is not available
and the user is given the chance to retry the job.

If this occurs, if you start the RIP input channel before the user retries the job,
the job will restart successfully.

Using More than One Method

The RIP can use any combination of the above input types and listen on all active
inputs. When several inputs want to send data, only one job can reach the RIP at a time
but the other inputs may be able to receive and buffer data for later rendering.

To accept input from several sources, create and enable the sources you want in the
Input Controller. The RIP automatically monitor all enabled sources as soon as the
input system is started with the Start Inputs menu option.

Enhanced File Management and Printing for Mac Users

To further enhance the printing options for Mac Users, an additional application is
supplied, called ExtremeZ-IP.

This installer is automatically copied into your AppleTalk folder in the RIP folder,
during installation.

For details of the ExtremeZ-IP application please refer to the Manual supplied in this
folder.
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Calibrating

Calibrating

Why Calibrate

The function of Calibration Curves is to linearize output on your plates. There are
several approaches on the use of the remaining curves. Generally, if you use the actual
press calibration curve to linearize your press then you will be printing with linear
plates that will produce flat images. For some users this will be the desirable effect, as
a 10% tint on screen will reproduce a 10% tint on the printed sheet; this is preferable
for spot colour users.

However, in CMYK (4 colour process) work, the flat image created by a linear output
will give a dull uninteresting image. In these cases use of the Intended Press curve or
tone curves will provide the needed correction and are used to “put back” the dot gain
that is assumed in the pre-press process.

Although the calibrations that we include in the RIP installation process are reasonable
starting points, you may find that it will be necessary to create calibration curves for
your press, papers, and inks to produce high quality printed results.

Using Calibration to Linearize Output on Your Plates

It is necessary to have an existing Page Setup to use this calibration procedure.
Follow the instructions in this document to create you own Page Setup or
apply the calibration procedure to one of the standard Page Setups created
during RIP installation by printing the config.ps file.

o Start the Navigator RIP.

¢ If necessary, open the Output Controller / Monitor window by either pressing
Ctrl+O or choosing Output -> Output Controller from the RIP menu.

:ﬂl:lutput Controller / Monitor : x|

Active Dueus Held Queue

Digabled

¥ Dizable output

e} I Hemovel Fiam |

Delete: | WY

Items: O Uszage: OKb Digk. free: 4.90G0 ltems: 0 Uszage: IKb

* Be sure that Disable Output is checked. This will allow you to control the start of
printing in the next steps.
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¢ Choose Output -> Print Calibration from the RIP menu.

Print Calibration E il

Pririt fior: IF'r-:u:e&x Colars anly j

Print uncalibrated target L\\J

Brint calibrated target

Print uncalibrated press target

Erint zalibrated prezs target

Erint expozure sweep

Fram: Ta Step:

[0 f256 1

From Fage Setup(s]:

Plates for Press

<

Cancel |

Calibrating

Choose a page setup and click on Print uncalibrated target. The calibration target
will be ripped and written to disk.

Load a plate onto the PlateWriter's Alignment Mat and move it to the READY-posi-
tion as described in “Loading Plates” earlier in this manual.

Press and hold the [SETUP] key on the Control Panel for 1 sec.
In the Output Controller/Monitor window select Uncalibrated target in the Active

Queue.

Click on the Info button to open the ThroughPut Info dialogue.

x

Job: 1. Uncalibrated T arget: Mono Calibration Test Strip [K)

Output device: IPIateWriter 24881 j

Configure device... I

288000 Verhcal
288000 Horizontal

Rezolution;

dpi ™

FPage width: 260
Fage height:  9.00

Fage layout. . |

I inches "I

[T Megative
[ Tiim page

Size on digk: a515kb
[Cazsette: I vI
Evposure: I

Copies to print: I'I

Copies printed: 1

Change roam colar.. I

[~ Don't delete page

¥ Change all pages in job

]

M

Cancel
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Calibrating

¢ Click on Page layout....

Page Layout : ﬂ

H—O——# Device Wwidth [0 29.00
Device Length [DL]: 40.00

Fy

|
L4

M edia Width [bw: 28.00
tedia Length [kL]: |4D.DEI

Top Margin [Th]: Im

[

|l
(M
I

Ty

[ Center page on Media ‘width

Battorn Margin [BR ] 37.40
[~ Center page on Media Length

Left b argin [Lkd]: naa

Right k4 argin [Rbd]: 20.00

Page width:  9.00 Iinches "I Select units: Iinches ]'
Page height: 2 60 Cancel |

e Check that the Media Width, Media Length and Margins are correct for your plate.
(The calibration target is pretty small, but you should check to ensure the margins
will put it inside your printing area).

e Uncheck Disable Output in the Output Controller / Monitor window.

A target similar to this illustration will be printed.

(Uncalibrated Target for device ‘PlateWriter 2480 1 bit Double’: uncalibrated N
Precision Screening: NA D Max / Min

Resolution: 2880.0 x 2880.0
Exposure: NA

Screen Frequency: NA
Screen Angle: NA

Screen Spot: Contone
Separation Color: Gray
RIP Serial No: 25177

D Max / Min

ACVWXESACVWXESALYWXESASYW

Qu rter-filiseif{oin test - use & lens :':':':'anm
Reference Number: 7 Tue 30 Oct 2007, 09:10:42

o After the target has printed, remove the plate from the PlateWriter.
o Place the plate on the front of the PlateWriter's Finishing Unit.

» Use a high quality reflection densitometer capable of reading stochastic dots, or
comparable device, to measure the dot% for each of the patches on the printed cali-
bration target.
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Calibrating

¢ Choose Output -> Calibration Manager from the RIP menu.

Calibration {Dot Gain) Manager 4 x|
Device: | Platelwriter 2488 1 bit D 7 | Color Space: |
I anne | Rezolution | Dat shape | Freq | E;-:pl +/- | Frofilz | Status |
24881 bitD 234/... 2880.0-28.. DEEDSZPWwW [ary) [nfa) v Linear U
Edit fram uncalibrated taraet. | Edit frarn calibrated target. . |

Mew. . | Eopy.. | [e|ete |[% Selent | 0K I Cancel |

e Choose the same Device type as was used to print the target.
 Select Monochrome as the Colour Space.
o Click on New....

Edit uncalibrated target for PlateWriter 2480 1 bit Double # il

—Warning Criteria

Frofile: | j

I Resofion:  [28200x20800 = [dni =]

v Dot shape: IDEEDS2F’W j

[~ Screen freg: | : | I j

[" | Exposure: I— v Use for Pos & Neg
Mame: Channel: I Gray ﬂ

Add. . I o [elete I

Measurements ast | Positive % Dot | [ Megative media

[ Farce solid colars
o0 20 40 60 @0 100 150 200 300 400 450 500
jooo |00 f7o0  fwo0  [1z00 {1400 f2200 3000 f4200 [53,00 5800|5400
550 GO0 700 600 G50 900 920 840 8960 330 1000
[5a.00 7400 [e200 9000 [3400 [S600 [97.00 (3800 9900 [98.00 [100.00

I (T [, R, A S R (W PR e
Smooth | E:-:tlapolatel Clear | Rezet | |mpaort | QK I Cancel |

e Name the new calibration and enter the modified column of Dot% measurements in
the edit boxes. You may Smooth the data after it is entered.

 Click on OK in this window and in the Calibration Manager window to save your
profile.
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Calibrating

Including the Linear Calibration in Page Setups

Editing the Page Setups

» Choose Navigator -> Page Setup Manager from the RIP menu to open the Page
Setup Manager window.

x|

Name | Device | Resolution | Calibration | Separations Style |
Default Page Setup Preview 1000 [None] CMY'K. Composite
GTOSZ Pre-Sepera.. Plate\wiiter 248 28300 Pw2000... Pre separated
GTOS2 In-RIF Sep... Platewiiter 248 28800 Pwi2000... Separations [ChvK]
AEBDick 9810 Pre-5 ... Plate\wiriter 248 28300 Pw2000... Pre separated
ABDick 9810 In-RI..  Plate\wfriter 248... 28300 Pwi2000... Separations [ChvK]
[Jh46 Pre separated  Platehw/friter 248.. 28800 Pw2000... Pre separated
OM4E In-RIP Sepa.. Platehw/iter 248, 28800 Pwi2000... Seperstions [CMYE + spot]

Edit,.

LCopy. | Delete | Units. Idp\ 'I
oK I Cancel |

o Select the Page Setup that was used when printing the uncalibrated target and click
on Edit to open the Edit Page Setup dialogue.

x
— Dutput Device — Rezolution
Device: Urits:
Configure device... | |2880.D w 2EE0.0 j Idpi j
ProofFeady; | j ¥ Overide rezolution in job
— Separations, Screening & Colo-———————— 1~ Processing

Style: ISepalations [CMYE + spot] j P | Optimizatior: INone j

Color: I[ND Color Management) j ml Erpoae I

— Trapping
Method: [Mane) 3 Canfigure, .. I I Enable Feature
7 .
Freferences: | I J
r— Calibration & Dot Gain r Effect: -
i MNegati
Calbration:  [2488 1 bitD 234371 = : o
e H I Mirmarprint
Tone Curves: 8 >
I[ ol J [~ Contral strip
Intended Press: I[Eommercial A j Hofe m
Actual Press: IEuropean Gain j W e
— Caszette & Page — Sealing
[Eagsefte; I j @l
Wertical: I‘I 00.00 %

Page lapout...

Impositon: I[N = j El Harizantal I'I (00.00 e

Locelerate, | Options... | POF Optiohz. .. | Save bz I Cancel |

L

¢ In the Calibration & Dot Gain section select the Calibration you just created.
» Leave the Tone Curve set to (None).

 Save the edited page set up by clicking on OK in this window and in the Page Setup
Manager window.
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Confirming your Linearization on Press

e Choose Output -> Print Calibration... from the RIP menu.

Calibrating

¢ In the dialogue box, choose the page setup just edited and click on Print calibrated
target. The calibration target will be ripped and written to disk.

 Follow the procedures used for printing the uncalibrated target, and confirm that the

output is linear on your plate.

Calibrating your Press

Calibrating your press using the Actual Press Curve function will provide you with a
linear press sheet, so that 10% on screen prints as 10% on press, 50% as 50% etc.

If we stop here, there are many circumstances where this, whilst being accurate, is not

really desirable.

Typically older press work produced by film will suffer press gain at around 20% and
this gives a warm, strong image. A linear calibration will often produce a very
flat-looking result. However, linearising your press is important since it provides a
starting point and removes the variables caused by varying press gains and worn press

rollers which can be created in a multi-press environment.

Once you have linearised your press and have created a calibration which we call the
“Actual Press” calibration, we can then add an intended press calibration curve, thus
enabling a print shop with multiple presses to create a more consistent and even

calibration across all its work.
o Start the Navigator RIP.

* If necessary, open the Output Controller / Monitor window by either pressing
Ctrl+O or choosing Output -> Output Controller from the RIP menu.

Eﬂutput Controller / Monitor

Active Quesue

Items: O Uzage: OKb

Held Queus

Disabled

[V Disable output

|nfa | Hemovel

Foam

Delete: |ESEE

Disk free: 4.90Gb

Items: 0

Uszage: Kb

» Make sure that Disable Output is checked. This will allow you to control the start of

printing in the next steps.

» Ensure that you have applied a Plate calibration to the page setup you wish to create
a press calibration for (see earlier in this chapter).
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Calibrating

¢ Choose Output -> Print Calibration from the RIP menu.

Print Calibration ]

Frint far: IPTDCESS Calars anly

&

Print uncalibrated target

Frint calibrated target

Frint uncalibrated PIfss target

e
Brint zalibrated press target

Brint edposlie sWeep

Frorm:

To: Step:

o

256

1

From Page Setup(s]:

Default Page Setup

GTO5Z Pre-Seperated
GTO5Z InRIP Seperations
ABDick 9810 Pre-Seperater
ABDick 9810 In-RIF Seper:
[AM4E Pre separated

[M4E In-BIF Separations
5M52 Pre-Seperated

Cancel |

* Choose a page setup and click on Print uncalibrated target. The calibration target
will be ripped and written to disk. You should get four separations.

* Load a plate

* In the Output Controller/Monitor window select Uncalibrated target in the Active

Queue.

Click on the Info button to open the ThroughPut Info dialogue.

ThroughPut Info i

1. Unzalibrated Target; Mono Calibration Test Stip (K]

Job:

X

Cutput device:

| Platetwsriter 243531 = |

Configure device. .. |

2880.00 Yertical
2880.00 Hoarizontal

Rezaolution:

-

dpi

Fage width: 260 Iiru:hes "I
Fage height; 3.00

[T Megative

Fage layout. . I _

[ Trim page
Size on disk: a515kb
Eazzette: I j
Exposurne: I

Copies to print; |1

Copies printed: 1

Change roam calor. . I

[T Don't delete page

¥ Change all pages in job

K.
Hhy

Cancel
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Calibrating

¢ Click on Page layout....

Page Layout E |

H—O——# Device Wwidth [0 29.00
Device Length [DL]: 40.00

Fy

|
L4

M edia Width [bw: |29.DEI
tedia Length [kL]: |4D.DEI

Top Margin [Th]: Im

(M
I

[
|l

Ty

[ Center page on Media ‘width

Battorn Margin [BR ] 37.40
[~ Center page on Media Length

Left b argin [Lkd]: naa

Right k4 argin [Rbd]: 20.00

Page width:  9.00 Iinches "I Select units: Iinches ]'
Page height: 2 60 Cancel |

e Check that the Media Width, Media Length and Margins are correct for your plate.
(The calibration target is rather small, but you should check to ensure the margins
will put it inside your printing area).
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Calibrating

e Uncheck Disable Output in the Output Controller / Monitor window.
Once the Throughput window shows activity, re-check the Disable Output
checkbox.

A target similar to this illustration will be printed.

(Uncallbrated Target for device ‘PlateWriter 2480 1 bit Double’: uncalibrated N
Precision Screening: NA D Max / Min D Max / Min
Resolution: 2880.0 x 2880.0

Exposure: NA

Screen Frequency: NA
Screen Angle: NA
Screen Spot: Contone
Separation Color: Gray
RIP Serial No:

[T Yy
XX

ConLgaL- {26 1-Jow 821 -

06AMXBRIGAMXBRICAUATRIGH mx BIOGAMXEE
AeVWXESAeVWXESIEVWXESIBVWIZSaCVWXEs

@u nter-fillserif-join test - use & lens :':':':'XXXmmm
Reference Number: 7 Tue 30 Oct 2007, 09:10:42

 After the target has printed, remove the plate from the PlateWriter.
* Place the plate on the front of the PlateWriter's finishing unit.
* Load the next plate and repeat the above procedure for each plate.

 Each plate should then be put on the printing press, and an even ink density should
be achieved before printing reference sheets.

In Europe the Fogra Standard suggests selecting three typical types of paper stocks:

- Gloss Art: Set the ink densities to C=1.37 D, M=1.4 D, Y=1.03D, K=1.53 D
- Silk /Matt: Set the ink densities to C=1.16 D, M=1.24 D, Y=1.01 D, K=1.46 D
- Unbolted: Set the ink densities to C=0.76 D, M=0.93 D, Y=0.75 D, K=0.97 D

Each paper stock reacts differently to the press ink and changes the gain achieved on
press. Similarly the amount of ink laid down will impact results. So if you do not wish
to adhere to the Fogra standards, then ensure you have some consistent densities that
you will to continue to work with.

For example, standard Commercial Work in the USA would typically see the ink

densities set to C=1.37 D, M=1.38 D, Y=1.06D, K=1.75D

* Run each stock through the press, ensuring your reference sheet achieves the correct
ink density.

* Once the sheets are dry, use a high quality reflection densitometer capable of read-
ing stochastic dots, or comparable device, to measure the dot percentage for each of
the patches on the printed calibration target. It is not unusual for each ink to achieve
a different gain characteristic, so you will need to separately measure each colour
printed.
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¢ Choose Output -> Calibration Manager from the RIP menu.

Calibrating

Calibration {Dot Gain) Manager 3 x|
Desvice: IF'linting Press j Calor Space: ICMYK j
M ame | Rezolution | Dot shape | Freq | Epr +/- | Press | Status |
Edit fram uncalibrated target... | Edit from calibrated target... |

Mew... Copn.. | [1elete | Select ] Catcel |
e Choose Printing Press as the Device type.
» Select CMYK as the Colour Space.
¢ Click on New....

Edit uncalibrated target for Printing Press _: il

W arning Criteria
Press: I Linear j
I Resolutior; I— Werlical: Iﬁ
I Huarizatital:
[ Dot shape: I vl
[ Screen freq: | R | I j
I Evposure: I— ¥ s for Pos i Heg
M arne: I Chanriel:
Add...
tMeazurements as: Iz Dot j i [Hegative

[Other calaors in job)

¥ Farce solid colars

C100 C35 a0 Cas 80 C70 CE0 Ca0 C40 C30

C20 C15

[10000 [95.00 [a0.00 [85.00 [S0.00 7000|6000 [50.00 [40.00 [30.00 2000 [15.00

ci0 ca CE C4 cz co

[tooo [soo  [eoo  f400 f2o0  [o00 | | | |

Smooth | E:-:trapolatel Clear | Feset | |mpaort |

o |

Cancel |

e Name the new calibration in relation to the press and paper type that was used.

¢ Select the press type as linear and select the first colour channel Cyan to enter the

cyan data into.

* Enter the modified column of Dot percentage measurements in the edit boxes.
* Once you have entered the Cyan data select the Magenta channel and enter the data

measure for the magenta output.
* Repeat the above for the remaining colours.

 Click OK in this window and in the Calibration Manager window to save your pro-

file.
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Calibrating

Including the Press Calibration in Page Setups

Editing the Page Setups
e Choose Page Setup Manager from the RIP menu to open the Page Setup Manager

window.
x

Name | Device | Resolution | Calibration | Separations Style |

Default Page Setup Preview 1000 [None] CMY'K. Composite

GTOSZ Pre-Sepera.. Plate\wiiter 248 28300 Pw2000... Pre separated

GTOS2 In-RIF Sep... Platewiiter 248 28800 Pwi2000... Separations [ChvK]

AEBDick 9810 Pre-5 ... Plate\wiriter 248 28300 Pw2000... Pre separated

ABDick 9810 In-RI..  Plate\wfriter 248... 28300 Pwi2000... Separations [ChvK]

[Jh46 Pre separated  Platehw/friter 248.. 28800 Pw2000... Pre separated

OM4E In-RIP Sepa.. Platehw/iter 248, 28800 Pwi2000... Seperstions [CMYE + spot]
Ediit,.. LCopy. | Delete | Units. Idp\ 'I

’TI Cancel |

o Select the Page Setup that was used when printing the uncalibrated target and click
Edit to open the Edit Page Setup dialogue.

e page setup x

— Output Device — Rezolution

Device: |Plateiwiiter 2488 1 bit Double = | 3

Urits:

Configure device... | |2880.D w 2EE0.0 j Idpi j

ProofFeady; | j ¥ Overide rezolution in job

— Separations, Screening & Color — Proceszing

Shyle: | j El O plimization: INone j
Color: | ﬂ El Exposure:; I

— Trapping
{ettiad; [Mane) o Canfigure, .. I I Enable Feature
e -
Freferences: | j | {:' ‘ll I J
r— Calibration & Dot Gain r Effect: -
MNegati
Calibration: I j I 2ot
ml H I Mirmarprint
Tane Curves: 8! o
I[ e J [~ Contral strip
Intended Fress: I j Rae m
Sectual Press: I j W e
— Caszette & Page — Sealing
[Eagsefte; I j @l
Wertical: I‘I 00.00 %
Page lapout... |

Impositon: I[N = j El Harizantal I'I (00.00 e

Locelerate, | Options... | POF Optiohz. .. | Saveﬁ-‘-.i.. I Cancel |

¢ In the Calibration & Dot Gain section select the Calibration you just created from
the Actual Press calibration list.

e Leave the Tone Curves and the Intended Press curve set to (None).

* Save the edited Page Setup by clicking OK in this window and in the Page Setup
Manager window.
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4-63

Why Use Intended Press or Tone Curves?

The calibration process we have outlined is used to linearize the printing process using
the PlateWriter 2000.

Linear printing means that a nominal 50% dot (gray level) will print as 50% on press.
Typically this will result in light or “washed out” looking print since most images are
pre-compensated for 20% dot gain. This means that images are generally prepared
expecting a nominal 50% dot to print as 70%.

Intended Press Curves are used to add the expected gain back into the press profile.
Tone Curves are used to modify this further to create cool looking images or warm
images. We have not included any tone curves so this section details the use of the
Intended Press Curve to create the expected dot gain from conventional film etc.

We have included curves for Standard (20%), 15%, and 22% dot gain along with
Commercial, SWOP and Forgra curves with the Navigator RIP. These values are a
good starting point.

You may need to fine tune these Intended Press Curves to meet your particular
requirements. However to use one of the existing Intended Press curves, follow the
procedure below to implement the Intended press curve in your Page Setups.

Including the Intended Press Curves in Page Setups

e Choose Page Setup Manager from the RIP menu to open the Page Setup Manager
window.

* Select the Page Setup that was used when printing the uncalibrated target and click
Edit.

¢ In the Calibration & Dot Gain section select as the Intended Press curve one of the
curves included in the Navigator RIP installation or one of the curves loaded when
printing the config.ps file, or any custom Intended Press curve you may have
created.

* Save the edited Page Setup by clicking OK in this window and in the Page Setup
Manager window.

* You can confirm if the output of your intended curves achieves the results you re-
quired by printing a Calibrated Press Target.
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Backup & Restore your NavigatorRIP Configuration for Windows

Backup & Restore your NavigatorRIP Configuration for
Windows

ﬂ It is very simple to backup your configuration of the Navigator RIP.

If you follow this simple backup procedure, you will preserve all of your
Passwords, Memory settings, Calibrations, Tone Curves, Device and Page
Setups etc.

n Having a backup of your RIP configurations is likely to save you hours of

work if any problems occur with your workstation or if you need to reinstall
the Navigator RIP.

Configuration Backup

Having configured your RIP follow the instructions below to make a backup file of
your settings:

Start the Navigator RIP.
Select Navigator -> Print file from the RIP Menu.

In the print dialogue, set the Page Setup to Default Page Setup and the Files of
Type to PostScript (.ps)

Choose the file BackupConfiguration.ps which is found in C:\Program
Files\Xitron_7.1r0\ Utilities.

Click on Print.
This will create (or overwrite an older version of) config.ps and put it in the same
folder as BackupConfiguration.ps.

Make a backup of config.ps on removable media and store it in a safe place.

How to Restore your Configuration

Follow the install instructions for Windows on the Navigator RIP install CD.
When you are instructed to print the config.ps file from the install CD, print the
config.ps file which you have backed up instead.

Follow the instructions to configure the RIP memory and dongle passwords.
Your entire configuration will then be restored, and you can resume work.
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Part 5: Troubleshooting

General

If the PlateWriter does not work properly, refer to the following pages to find the

paragraph that comes closest to your problem. The trouble shooting guide is divided
into 3 sections:

* Problems with the finishing unit
* Problems with printed material

To change a fuse, switch off all power to the machine first.

Always ensure that the new fuse is of the correct size and rating according to
the diagram.

Operating Manual - PlateWriter" 2000 0749



Troubleshooting

Problems with the Finishing Unit

Problems with the Finishing Unit

Indicator Status and Error Codes

The finishing unit's status indicator lamp has several ways to indicate the current

status of the unit and/or unit errors.

GREEN - STEADY

Finishing unit is ready.

GREEN - 1 FLASH

Processing.

Wait for steady green signal before next plate is
put on the conveyor.

GREEN - 2 FLASHES
BUZZER SOUNDS

Plate on conveyor when oven is not ready.

Remove plate and wait for steady green signal
before plate is put on the conveyor.

GREEN - 3 FLASHES

Plate too long or too short.

Remove plate.

RED - 1 FLASH

Unit is not ready because conveyor and/or oven
sensor is covered.

Uncover both sensors.

RED - 2 FLASHES

Program selection out of range.

Set correct program.

RED - 3 FLASHES
BUZZER SOUNDS

Bulb error - one or more bulb in the oven are
blown.

Power the unit off, replace bulb, then power the
unit on again.

RED - 4 FLASHES

Motor regulation error - motor/conveyer is

blocked.

Power the unit off, remove obstacle, then power
the unit on again.
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Problems with Printed Material
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